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FOREWORD
Since its establishment in 1976, Acharya Nagarjuna University has been forging ahead

in the path of progress and dynamism, offering a variety of courses and research contributions.
I am exlremely happy that by gaining a B++ (go-95) grade from the NAAC in the year 2003,
the University has achieved recognition as one of the front rank universities in the country. At
present Acharya Nagarjuna university is offerihg educationar opportunities at the uG, pG
levels apart from research degrees to students from about 300 affiliated colleges spread over
the three districts of Guntur, Krishna and prakasam.

The University has also started the Centre for Distance Education with the aim to
bring higher education within reach of all. The centre will be a great help to those who cannot
join in colleges, those who carnot afford the exorbitant fees as regular students, and even
housewives desirous of pursuing higher studies. with the goal of bringing education to the
doorstep of arr such peopre, Acharya Nagarjuna university has started offering B.A., ano
B Com courses at the Degree rever and M.A., M.com., M.sc., M.B.A. and L.L.M. courses at
the PG level from the'academic year 2003_2004 onwards.

To faciritate easiei understanding by students studying through the distance mode,
these self-instruction materiars have been prepared by eminent and experienced te ers.
The lessons have been drafted with great care and expertise within the stipurated time by
these teachers. constructive ideas and scholarly suggestions are wercome from students
and teachers invorved respectivery. such ideas wifi be incorporated for the greater efficacy of
this distance mode of education. For crarification of doubts and feedback, weekly crasses ano
contact classes will be arranged at the UG and pG levels respectively.

rt is my aim.that students getting higher education through the centre for Distance
Education shourd improve their quarification, have better emproyment opportunities and In
turn facilitate the country's progress. lt is my fond desire lhat in the years to come, the centre
for Distance Education wilr grdw from strength to shength in the form of new courses and by
catering to larger number of people. My congratulations to all the Directors, Academrc
co-ordinators, Editors and Lesson - writers of the centre who have herped in these endeavours.

Prof. Y. R. Haragopal Reddy
Vice - Chancellor,

Acharya Nagarjuna University
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Lesson 1: Basic Concepts

Objectives:

The objective of this lesson is primarily to define what a computer is
a.nd to give a brief insight into the evolution of computer, its types and
the use of computer in our regular life. After the completion'of this
lesson the student will be able to understand:

. What a computer is.
o Characteristics and limitations of a Computer.. History of Computers.
. The evolution of Computer through five generations.. Types of Computers.
o Advantages of using Computers.
r Applications of Computers.

Structure of the Lesson:

1.1. Introduction
L.2. What is a Computer?
1.3. Characteristics of a computer
1.4. Limitations of a computer
1.5. Major components of a computer
1.6. History of Computers
L.7. Computer Generattons
1.8. Types of Computers
1.9. Advantages of Computer
1.10. Applications of Computers
1.11. Summary
1.12. Technical Terms
1.13. Model Questions
1,14. References



1. 1. Introduction:

We are living in an information age. Every type of job-relies. upon

g"iting inforriration, using it, mana-qing it, and relaying information to-

others. Computers enadle the efficient processing and storaqe of

iniormation. The information processed by the computer becomes

digita|'soComputersaredirectlyresponsib|eforthesmoothrunning
of this information age

Computers are placed everywhere we look, and even in places we

can't see. Computers check out our groceries, book tickets for our

iorrn"y, fill fuel in our vehicles, dispense money at the ATM' turn the
'neat on'anO'off, and control the way our car runs' They're everywhere!

The word "Computer" is derived from the word "COMPUTE"' which

means to calculate '

Before learning morF hout computers it is suggested that.one should

have a basic idea ot . data, information and instruction is'

Data:
Facts, symbols,
meaning, is called

Information:
Processed data is

names, numbers or anything, which tras a little
as Daia. Ex: hanuman, L23, ramu, 10:50 etc'

known as information'

Instruction:
Instruction is a command, which operates on the stored data'

1.2.What is a ComPuter?

Computer is an electronic device, which

takes data as input, processes it ancl

oroduces information as output.



1.3. Characteristics of a Computer:

Computers are becoming popular day by day because of their
continuously increasing power and its usefulness. The following are
some of its cha racteristics.

Accuracy:
computers always produce correct calculations, If mistake occurs in
any calculation, they are due to human errors like entering wrong data
or incorrect instruction.

Speed:
computers can carry out instructions in less than one millionth of a
second.

Versatality!
Computer can perform any type of work,

Storage capacity:
computers have the capability to store large amounts of instructions
and data, when we ask for data it supplieJ the stored information to
us,

Repetitiveness:
Computers are capable of performing any task given to them
repeatedly.

1.4. Limatations of Computers:

Lack of Commonsense:
Computer is only a tool. It cannot think. It does not have
commonsense or intelligence of its own, computer acts like a human
upto some extent.

Inability to corect:
A computer cannot correct wrong instructions by itself.

Dependence on human instructions:
A. computer cannot generate any information on it,s own. We must
give the correct instructions.



A System is defined as a set of interacting elementsr responding to
input, ,o as to produce outputs. The computer system consists of the

following elements:

Hardware:

The physical components of a computer system are called as

hardware. i'e. components, which can be seen and touched' It
includes input devices, output devices, electronic circuits, capacitors

etc.

The following are some of the hardware components'

1.5. Major comPonents of a computer:

Keyboard

Software:

iloppy Disk

A program or a collection of programs is known as software' Program

is L slquence of instructions'designed to dlrect a computer to perform

certain tasks.

Note: A floppy disk is a hardware, but contains a program stored on it'
which is a software'

@ qffi
chiP Scanner
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1.6. History of Computers:

History of computer could be traced back to the effort of man to count
large numbers. Computer history starts with the development of a
device called ABACUS by Chinese around 3000 BC. This device was
used for counting,

Calculating Machines:

It took over generations for early man to build
mechanical devices for counting large numbers. The
Egyptian and Chinese people developed the first
calculating device called ABACUS, The word ABACUS
means calculating board. It has a number of horizontal
bars each having ten beads, Horizontal bars represent
u n its, tens, hundreds, etc.

Napier's Bones:

In the early 1600's, a Scottish mathematician called John Napier
invented a tool called Napier's Bones, which were multiplication tables
inscribed on strips of wood or bone. He also invented logarithms,
which is a technology that allows multiplication to be performed via
addition.

Slide Rule:

English mathematician Edmund Gunter developed the slide rule. This
machine could perform operations like addition, subtraction,
multiplication and division. It was widely used in Europe in 16th
century.

Pascal's Adding and Subtracting Machine:

The mechanical adding machine was invented by a 19 year old French
boy named Blaise Pascal way back in the year 1642, This machine
could perform addition and subtraction. The machine consisted of
wheels, gears and cylinders.



i
Leibniz's Multiplication and Dividing Machine:

Blaise Pascal machine was further improved by Gottfried Wilhelm
von Leibniz, a German mathematician to perform all four arithmetic
operations This machine could perform boih multiplication and

division.

Babbage's Analytical Engine:

It was in the year 1823, a famous English man
Charles Babbage designed a mechanical
computing machine to do comPlex
mathematical calculations. It was called
difference engine. Later he developed a
general-purpose calculating machine called
analytical engine. Charles Babbage is called the
father of comPuter.

Augusta Ada Byron -countess of Lovelace:

In the year 1842, Ada Love|ace with her set of instructions became

thepioneerofmodernprogramming|anguagesandhistorianshave
accorded her the status of world's first computer programmer'

Mechanical and Electrical Calculator:

In the beginning of lgth century the mechanical calculator was

developed io perform all sorts of mathematical calculations. It was

widely upto 1960s. Later the rotating part of mechanical calculator was

replaced by electric motor. so it was called the electrical calculator.

Modern Electronic Calculator:

The electronic calculator used in 1960s was run with vacuum tubes,

whichwasquitebu|ky.Lateritwasrep|acedwithtranslstorsandasa
result the size of calculators became too small. The modern electronic

calculator can compute all kinds of mathematical computations and

mathematical functions. It can also be used to store some data

permanently. Some calculators have in-built programs to perform

some complicated calculations.
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1.7. Computer Generations:

The evolution of computer started from 16th century and resulted in the
form that we see today. This period, during which the evolution of
computer took place, can be divided into five distinct phases known as
Generations of Computers. Each phase is distinguished from others on
the basis of the type of technology used.

First Generation (Period 1951- 58):

First generation computers used Thermion valves or Vacuum tubes for
circuitry, magnetic drums for memory, and were often enormous,
occupying entire room, They were very expensive to operate and in
addition to using a great deal of electricity, generated a lot of heat,
which was often the cause of malfunctions. First generation computers
relied on machine language to perform operations and could only solve
one problem at a time. Input was based on punched cards and paper
tape, and output was printed on paper (printouts).

Some of the computers of this generation were: UNIVAC,ENIAC,
EDVAC, EDSAC.

Second Generation (Period 1959-64):

With the invention of the Transistor at Bell labs in L947 by Wiliam
Shockley, John Bardeen and Walter Brattain, it became clear that
transistors would replace vacuum tubes, Transistors are smaller than
vacuum tubes and have higher operating speed, more reliable, used less
energy and generated less heat. Thus the size of the computer got
reduced considerably. The transistor was invited into Second-
generation, computers moved from binary machine language to
symbolic or assembly language. This allowed programmers to specify
instructions in words. High-level programming languages were also
being developed at this time. These were also the first computers that
stored their instructions in their memory, which moved from a magnetic
drum to magnetic core technology. It is in the second generation that
the concept of Central Processing Unit (CPU), memory, programming
language, input and output units were developed. The programming
languages such as COBOL, FORTMN were developed during this period.
Some of the computers of the Second Generation were IBM 1620, IBM
1401, CDC 3600.



Third Generation (1965 to 197O):

The third generation computers were introduced in 1964' They used

Integratei Circulfs (IC's)' These IC's are popularly known as Chrps'

Tranlistors were miniaturized and placed on silicon chips, called

semiconductors, which drastically increased the speed and efficiency of
computers. A single IC has many transistors, registers and capacitors
built on a single thin slice of silicon. so it is quite obvious that the size

of the computer got further reduced' Instead of punched cards and
printouts, users interacted with third generation computers through
keyboards and monitors interfaced with an operating system'

Operating system atlowed the device to run many different
applications at one timE with a central program that monitored the
memory. Computers of these generations were small in size, low cost,

large memory and processing $peed is very high. High-level language

.rjh ut BASrc (Beginners All purpose Symbolic Instruction Code) was

developed during this Periocl.
Some of the computers developed during this period were IBM-360,
ICL-1900, IBM-370, and VAX-750.

Fourth Generation (1971 to present):

with the invention of the microprocessor, thousands of integrated

circuits were built onto a single silicon chip' The present day

computersthatweseetodayarethefourthgenerationcomputersthat
started around 1975. It uses large scale Integrated circuits (LSIC)

bui|tonasing|esi|iconchipca|ledmicroprocessor.Duetothe
development oi microprocessor it is possible. to place computer's

centrai processing unlt (CPU) on single chip' 'These computers are

calfed microcomputers. Later very large scale Integrated Circuits
(VLSIC) replaced LSICS.

In 1981 IBM introduced its first personal computer for the home user,

andin1984App|eintroducedtheMacintosh.Microprocessorsmoved
out of the realm'of desktop computers into many areas of life as more

and more everyday products began to use microprocessors'

As these small computers became more powerful, they were linked-

togethertoformnetworks,whicheventuallyledtothedevelopmentof
th6 Internet. Fourth generation computers also saw the development

or eut.(cr"phical User Interface), the mouse and handheld devices.
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Fafth Generataon:

Fifth generation computing devices, based on artificial intelligence, are
still in development, though there are some applications, such as voice
recognition, that are being used today. The speed is extremely high infifth generation computer. The use of parallel processing - and
superconductors is helping to make artificial intelligence a ieality.
Quantum qomputation, moiecular and nanotechnology will radicaliy
change the face of computers in years to come. The goal of fifth
generatioi't computing is to develop devices that respond to natural
language input, capability of learning by themselves and also being
self-organized,

First Generation:

o Vacuum tubes for internal operations
o Primary Memory Limited
o Heat and Maintenance problem
o Punched cards for input and output

Second Generation:

D Transistors for internal operations.
o Smaller than vacuum-tube-built computers
o Thousand times faster than first-generation computerso Magnetic tapes and disks for secondary storages Increased processing speed and reliability
o Increased use of high-level languages

Third ceneration:

o
o
o

Fourth

o
o
o
o

Hundreds of transistors packed into a single integrated circuit
on a silicon chip for internal operations
Dramatic reduction in size and ccst
Significant increase in reliability, speed, and efficiency
Increased primary memory capacity

Generation:

Large scale and VISI for internal operations
Development of the microprocessor
Greater versatility in software,s
Introduction of microcompuiers and'super computers

.2



1.8. Types of Computers:

Computers can be classified into two categories: Analog and Digital
com puters

Analog Computer Digital Computer

Analog computers operate by measuring rather than counting'
These computers use signals as input, which can come from devices
like speedometers, thermometers etc. These signals are continuous
flow of physical quantities like speed, temperature, pressure etc.
Analog computer has only limited memory facility and is restricted in
the type of calculations it can perform,

Digital computers represents data in the form digits and all
operations are done on these digits at extremely fast rates. Digital
computers basically know how to count the digits. These computers
are mostly used in engineering and scientific calculations. Digital
watches are good example of a digital computer.

Hybrid computer is a combination of both analog and digital
computers. i.e., a part of processing is done on analog and a part on
digital computer. It provides greater precision than can be attained
with analog computers, greater control and speed than is possible with
digital computers, It can accept input data in both analog and digital
form. It is used for simulation applications.

Digital Computers are divided into the following categories:

. Mini Computers

. Mainframe computers
r Micro Computers :

. Super Computers



Now let us discuss the varieties of digital computers that we see todav.
They can be divided into different categories depending upon the size,
efficiency, memory and number of users.

Microcomputer:

Microcomputer is at the lowest end of the computer range in terms of
speed and storage capacity. These are most widely used computers
which we commonly refer to as ..personal Computers,, or .,Desktop
Computer". Its CPU is a microprocessor. The pC supports a number of
input and output devices. It can be used by only one user at a time.
Examples of microcomputer are IBM pC, PC-AT,

Mini Computer:

Mini computer is designed to support more than one user at a time. It
possesses large storage capacity and operates at a higher speed. The
mini computer is used in a multi-user environment in which various
users can work at the same time. This type of computer is generally
used for processing large volume of data in an organization. ihey are
also used as servers in Local Area Networks (LAN).

Mainframes:

Mainframe computer is a computer, which has capability to support
many terminals and peripherals. These computers operate at very high
speed, have very large storage capacity and can handle the woiklo;d
of many users, They are generally used in management of centralized
databases. They are also used as controlling nodes in Wide Area
Networks (WAN). Examples of mainframes are ICL, IBM 3000 series
and DEC.

Super computer:

Super computers are the fastest and most expensive machines, They
have high Processing speed compared to other computers. They also
have .multiprocessing techniques. These computers are used ,widery in
complex. scientific apprications like weather forecasting, geneti.
engineering, biomedical research, remote sensing, aircraft iesiln etc.One of the ways in which super computers are built is byinterconnecting hundreds of microprocessors. . Examples of
supercomputers are CRAY yMp, CMy2, CRAY XMp, PARAM from India
and IBM's Bluegean.
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1.9. Advantages of Cc.-'.puters:

a High rate of processing speed with reliability.
Huge volumes of data can be stored in the memory and any
particular data item can be retrieved at random in a fraction of a
second.
Solution of a much-complicated problem is feasible at a greater
speed.

. Processing of voluminous data saves a good lot of clerical labor,
which in turn reduces the processing cost.

. Performs operations efficiently even in environments inaccessible
to humans, such as furnace, poisonous atmosphere, vacuum,
unmanned satellite etc.

1.1O. Applications of ComPuters!

Computers were initially used for prime applications in the field of
mathematics and science. Their first effective utilization was made
in the field of military for decoding the messages of the enemy.
Then they entered the application of real time control systems like
landing on moon. Currently maximum number of computers are
being used in business and commercial sectors. The following are
the list of applications:

o Scientificapplications
. Weather forecasting
. Online reservations
. Business and office
. Banking sector
. Electronics funds transfer (EFT)
. Electronic commerce
. Process control
. Computer aided design (CAD)
. Computer aided manufacturing (CAM)
r Electronic mail (e-mail)



1.11.Summary:

In this lesson we discussed the major characteristics of a computer.
The speed, accuracy, memory and versatility are some of the features
associated with a computer. Computer performs operations
automatically. Computer system involves two major components
hardware and software. Hardware refers to physicar iomponents of a
system and software refers to a set of programs. The computer that
we see today was not developed over night. It has taken centuries ofhuman effort to see the computer in its present form today.
CgTqr!9o _history began with the development of a counting device
called ABACUS, later several evaluations including analog mlchines,
mechanical calculators, electrical machine and other modern
computers. computers are classified into several generations based onthe technology used in building the computer. There are five
generations of computers. over these generations the physical size of
computer has decreased, and on the other hand the processing speed
of computer has improved tremendously. The Computers have-proved
not only their presence but also their effectiveness in whatever field
they foray.

1.l2.Technical Terms:

chip: A tiny wafer of silicon containing miniature electric circuits that
can store million of bits of information.

VLSr (Very Large scare Integration): The use of integrated circuits
with 100,000 to a million logic gates.

Artificial intelligence (AI): The study of thinking process of humans
and representation of those processes via machines (computer, robots,
etc. )

Microprocessor :A complete centrar processing unit (cpU) contained
on a single silicon chip.

Laptop: Small, lightweight, portable battery-powered computers thatcan fit onto our lap. They have a thin, flat, liquid crystal Oispfay
screen.

E-mail (Electronic mail): A service that senos messages on
computers via local or global networks.



1.13.Model Questions:

1. What is a computer and explain the characteristics of
com Duter?

2. What are the major limitations of a computer?
3. What is Software and Hardware?
4. Briefly explain History of computers?
5. Explain Generations of computers?
6. Write about different types of computers?
7. Write short notes on advantages and applications

com puters?
of

l.14.References:

Prof,G.S.Prasad, M.Sc, M,S "Fundamentals of Computer -
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Lesson 2- Components of a computer

Objectives:

The main objectives of this lesson are:

. To understand the four basic operations of the computer.
' To know the basic components of the computer and their

functions.
. To know the function of memory and different kinds of memory.. To understahd the concept of cache memory and registers, _. To know about input and output devices,

Structure of the lesson:

2,1. Introduction
2,2. Operations of a computer system
2.3. Block diagram of a computer
2.4. Types of memory

2.4.L. Primary memory
2.4.2. Secondary memory

2,5. Cache memory
2.6. Registers
2.7. Input devices
2.8. Output devices
2.9. Summary
2.10.Technical terms
2.11.Model Questions
2.12.References



2.1. Introduction:

In the previous lesson we discussed about the history and evolution of
compuier. In this lesson we will have an overview of the basic design

of a computer. We will know how different parts of a computer are

organized and how various operations are performed between different
pirts to do a specific task' The internal architecture of computer may

differ from system to system, but the basic organization remains the

same for all computer systems.

2.2. Operations of a Computer System:

Computer system has four main stages: The Input stage- where

data is put into the computer. The Processing stage - where the data

is processed. storage and The output stage - where the results are

displayed.

Input:

Input is supplied to the computer with the
mouse, or another input device. These input
peripheral devices'

Processing:

Processing is done inside the computer in an
processing unit (CPU)' Processing is the
output.

use of a keyboard, a
devices may be called

area called the central
conversion of inPut to

Storage:

Storage refers to holding information in a specific place'

Output:

Output is the result of a computer
a monitor screen, heard through.
printers, and so forth '

process. Output maY be viewed on

speakers, Printed on PaPer with
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2.3. Block diagram of a computer:

Basic functional units of a digital computer includes three major parts:

" Input unit

" Central processing unit (CPU)
o Output u nit

Input Unit:

Computer processes data to produce some form of useful information
as output. To do this, a computer needs some kind of data (facts,
numbers, characters etc) to be processed called Input. So we need a
device to enter data into the comouter. Inout unit writes the
instructions and data into a computer's memory, Input unit of
computer is similar to our 'ears' and 'eyes' through which we receive
data. Input devices deal with original data. Various ir.rut devices in
use are:Keyboard, Mouse, Scanner, light pen, Graphic Tablet, Touch
panel, Optical Mark reader, Magnetic tapes, Magnetic drums.

Block Diagram of a Computer

, 
- ,eohtrol' -

Unit

Secondary storage

1* 
"A;ithiiilnid"'ii-6it6 -

: Unit(ALU)
Information
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Central Processang Unit (CPU):

The central processing unit (CPU) is an essentiat component of a
computer. Because it is the part that executes the programs and
controls the operations of all the hardware. The central processing
unit (CPU) is like our brain,
It consists of three units: - 1. Arithmetic and Logic unit (ALU)

2. Control unit (CU)
3, Memory unit (MU)

ALU (Arithmetic and Logic Unit):
Arithmetic and logic unit is the part of the CPU, where arithmetic and
logical functions are performed, i,e., mathematical or arithmetic
functions like addition, subtraction, multiplication, division etc. Logical
operations like logical AND, OR, NOT.

Control Unit:
The Control unit is.the circuitry that.controls the flow of information
through the processor and co-ordinates the activities of the other units
withi, r it. It also controls transfer of data between CPU and memory
and CPU and I/O devices.

Memory Unit:
Memory stores the input from input device and output from the CPU'

as well as the instructions that are followed by the CPU; All the
instructions, data, intermediate results of any calculation and final
output in the memory can be retrieved when necessary. The data and

commands are stored in the addresses called memory locations'
The amount of storage in the memory can be measured' The units of
measurement of memory are

bit=0 or1
nibble= 4 bits
lbyte=8 bits
1 Kilo byte (Ke;= 1624 Otr"t
1 Mega byte (MB)=1024 KB
1 Giga byte (GB) = 1024 MB

The are two types of memory, primary or main memory and
Eeeondary or auxiliary memory.

Output Unit:
output devices allo*t+s to get information from the computer. various
output devices are: M.onitor, Printer, Speakers, CRT - Cathode Ray

Tube, Plasma, LCD - tiql.itd Crystal Display'
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2.4. Types of Memory:

Memory:

Memory is the storage area where the computer stores the instructions
for solving a problem, the data to be processed, the intermediate
results and the final results until they are displayed.

Types of Memories:

Memory can be divided into two main categories:
. Main Memory or Primary Memory
. Secondary Memory or Auxiliary memory

Primary memory consists of data that are-actively being used. It is
typically high-speed, relatively small, is oftd[ volatile. It is sometimes
referred to as "M,ain Memory", It can be accessed immediately and
randomly. Primary memory is divided into RAM and ROM.

Secondary memory, also known as peripheral storage, is where the
computer stores information that is not_,current[ in use. It is typically.
slower and has higher capacity than primary storage. It is non-volatile.



2.4.1. Primary Memory:

Random Access Memory (RAM):
The primary storage is referred [o as random access memory (RAM)

because it is possibte to randomly select and use any location.of the

memory,Clirect|ystoreandretrievedata.Itisa|soca|ledread/write
memory. The storage of data and instructions inside the primary

rtorig" is temporar!. The contents of RAM are lost as soon as the

po*"i to the computer is switched off or if there is a minor fluctuation

in the power supply. The memories, which loose their content on

failure of power supply, are known as volatile memories' There are

different tYPes of RAM:
Statac ttAM (SRAM):
power is Provided to
rewritten PeriodicallY.

ThiS RAM will niaintain its data as long as

the memory chips, It does not need to be

SMM is often used as cache memory due

to its speed.
Dynamic RAM (DRAM):DMM. unlike SMM' must be

continuously re-writien in order for it to maintain its data' DRAM

is used for most s 'tem memory because it is cheap and small'

Read Only MemorY (ROM):
Storage ol program and data in the ROM is permanent' The ROM

itor"t" some ltandard processing programs supplied Uv !h9
manufacturers to operate the personil computer' The contents of ROM

can onfy be read by the CPLj, but it cannot alter the contents' The

basic input/output program is stored in.the-ROM' It examines and

initializes various equipment attached to the PC' The memories' which

do not loose their content on failure of power supply' are known as

non-volatite memories. ROM is non-volatile memory'

PROM (PROGRAMMABLE READ ONLY MEMORY): WC KNOW

that it is not possible to modify or erase programs stored in

ROt,t, but in PROM it is possible foll:.to store our program in

PROM chip. Writing of programs in PROM can only be done once--

EPROM(iRASABIE dNOEUMMABLE READ ONLY

MEMORY):Th|s memory chip overcomes the problem of PROM

and ROM. EPROM chip can be programmed time to time by
-rasing the information stored earlier in it. Information stored in

ipnori is erased by exposing it to ultraviolet light' It can be

i"progrutt"d using a special programming facility'
eepnbM: Stands f-or Eiectrically Erasable Program.mable Read

Oniy m"mory. This ROM can be written through the use of a

special software Program '



2.4.2. Secondary Memory:

Secondary memories are also known as Auxiliary memory. It is the
memory supplement to main storage. This is a non-volatile memory.
The term non-volatile means it stores and retains the programs and
data even after the computer is switched off. The operating speed is
slower than that of the primary storage, Huge volumes of data are
stored here on permanent basis and transferred to the primary storage
as and when requ ired.

The most common types of auxiliary storage devices are magnetic
tape, magnetic disk, floppy disk, hard disk, and optical disk. ihese
devices are divided into two categories based on the type of the
access: Sequential and Random. Magnetic tapes are examples of
sequential accessing devices in which the data can be accessed one
after another in a sequential order, In contrast, disks are random_
access devices in which the data accessing is direct, other examples of
direct access devices are magnetic disks, optical disks, zip disks etc.

Magnetic Tape:
Magnetic tapes are used for large computers like mainframe
computers where large volumes of data is stored for a longer time. In
PC we can also use tapes in the form of cassettes. The coit of storing
data in.tapes is inexpensive, Tapes consist of magnetized material that
store.data permanently, It similar to cassette tape used in a tape
recorder. Accessing data on tapes is much slower than accessing data
on disks. Tapes come in variety of sizes and formats,

Magnetic Disk:
lu'.9 qirt is a magnetic disk on which we can store computer data.
Hard disks hold more data and are faster than froppy disks. A singre
hard disk usually consist-s of several platters, Each platter requires tivo
read/write heads, one for each side. It rotates at very high speed.
Data is stored on both the surfaces of the disk. Magnetic-disk's are
most popular for direct access storage device, rach disk consists of anumber of invisible concentric crrcles called tracks. Information is
recorded on tracks of a disk surface in the form of tiny magnetic sjots,The presence of a magnetic s-pot represents one blf and its absence
represents zero bit.

''1,



Floppy Disk: ,

It ii similar to magnetic disk. Floppy disks are portable, because we

can remove them from a disk drive. Disk drives for floppy disks are

floppy drives. Floppies come in two sizes: They are 5'25 inch or 3'5
inin'in diameter. The capacity of a 5.25-inch floppy is 1'2 mega

bytes(1.2M8) whereas for 3.5 inch floppy it is l'44 mega

bytes(1.44MB). It is cheaper than any other storage devices' Floppy is

a low cost device particularly suitable for personal computer system'

Optlcal Disk:
Optical disks are a storage medium from which data is read and to
*'hi.h it is written by laseis. Optical disks can store much more data -
uoto 6GB. There are three basic types of optical disks' They are:

o Compact Disk/ Read Only Memory (CD-ROM)

o Write Once, Read ManY (WORM)
o Erasable OPtical Disk

2.5. Cache Memo'-r:

The speed of CPU is extremely high compared. to the access time of

mainmemory.ThereforetheperformanceofcPUdecreasesduetothe
slow speed of main memory. To compensate the mismatch in

operating speed, a small memory chip is attached between CPU and

main memory wnose access time is very close to the processing speecl

of CPU. It is catled cache memory. Cache memories are accesseo

much faster than conventional MM' It is used to store programs or

data currently being executed or temporary data frequently used by

the CPU. So each memory makes main memory to be faster and larger

than it really -is. It is very expensive to have bigger size of cache

memory, its size is normally kept small'

2.6.Registers:

rr'"cpuprocessesdataandinstructionswithhighspeed.Thereisa|so
movement of data between various units of computer. It is necessary

to transfer the processed data with high speed' So the computer uses

a number of special memory units called registers' They are not part

of the main memory but ihey store data or information temporarily

and pass it on as directed by the control unit'
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2.7 Input Devices:

Input devices are necessary to convert our information or data into a
form, which can be understood by the computer, A good input device
should provide timely, accurate and useful data to the main memory of
the computer for processing. Following are the most useful input
devices.

Keyboard:
The most often used input device is the keyboard. This is the
standard input device attached to all computers. The layout of
keyboard is just like the traditional typewriter. It also contains some
extra command keys and function keys. It contains a total of 101 to
104 keys.

Mouse:
Mouse is an input device that can be connected to our personal
computer. It rolls on a small ball and has two or three buttons on the
top. When you roll the mouse on a flat su rface, you control the
position of the computer's cursor, or pointer, on the screen. As you
slide the mouse forward, for instance, the cursor moves forward to the
top of the screen, With many programs, the computer conveys your
commands to the computer via on-screen pictures or icons. The cursor
moves very fast with mouse giving you more freedom to work in any
d irection.

Scanner:
The keyboard can input only text through keys provided in it. If we
want to input a picture the keyboard cannot do that. Scanner is an
optical device that can input any graphical matter and display it back.
The common optical scanner devices are Magnetic Ink Character
Recognition (MICR), Optical Mark Reader (OMR) and Optical Character
Reader (OCR).

Magnetic Ink Character Recognition (MICR): This is widely
used by banks to process large volumes of cheques and drafts.
Cheques are put inside the MICR. As they enter the reading unit
the cheques pass through the magnetic field, which causes the
read head to recogni7e the characters on the cheque.

Optical Mark Reader (OMR): This technique is used for
evaluation of objective type angwers. f,f e answering will be done
by darkening a square or circylar spdce by pencil. The OMR is



used to read the answers on the sheet and computer compares
them with the answers in the memory for evaluation.
Optical Character Recognition (OGR):
This technique unites the direct ieading and comparing of any
printed character. Suppose we have a set of hand written
characters on a piece of paper, the OCR is used to read and

comDare these with a set of patterns stored inside the computer.

2.8 Output Devices:

Visual Display Unit (VDU):
The most popular input/output device is the Visual Display Unit (VDU)'

It is also called the monitor' Monitor is used to display the input data
and to receive messages from the computer' The contents of the
memory can be viewed on a monitor..A monitor has its own box, which
is sepaiated froil the main computer system and is connected to the
computer by a cabte, In some systems it is compact with the system
unit. Ir can be color or monochrome'

Terminals:
It is a very popular interactive input-output unit. It can be divided into
two types: hard copy terr-ninals and soft copy terminals' A hard copy
terminal provides a printout on paper whereas soft copy terminals
provide visual copy on monitor, A terminal when connected to a CPU

sends instructions directly to the computer. Terminals can be classified
as dumb terminals or intelligent terminals depending upon the work
situation.

Pranter:
It is an important output device, which can be used to get a printed

copy of the processed text or result on paper. There are different types
of printers that are designed for different types of applications'
Depending on their speed and approach of printing. Printers are

classified as impact and non-impact printers. Impact printers use the
familiar typewriter approach of hammering a typeface against the
paper and inked ribbon. Dot-matrix printers are of this type' Non-
impact printers do not hit or impact a ribbon to print. They use electro-
static. chemicals and ink-jet technologi€s' Laser printers and Ink-iet
printers are of this type. This type of printers can produce color
printing and graphics. .,.
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2.9.Summary:

In general, a computer is a machine, which accepts data processes it
and returns processed information as output, As you become familiar
with software and hardware we will have a better understanding of
technology for business and for our home. Technology is a vast field
and learning it will be a life tong process.

In this lesson we discussed five basic operations that a computer
performs. That is input, storage, processing, output and control, A
computer accepts data as input, stores it, processes it as the user
requires and provides the output in a desired format. The storage unit
of a computer is divided into two parts: primary storage and
secondary storage. All computers have several parts in common:

. Input devices allow data and instructions or commands to be
entered into the system.

A means of storing instructions and data.
A central processing unit (CPU) which controls the processing. .

A means of returning the processed information in the form of
outDut.

2.1O. Technical Terms:

Bit: stands for binary digit. The smallest piece of computer
information, either the digit 0 or 1.
Binary code: The most basic language a computer understands, it is
composed of a series of 0s and 1s.
Memory: storage for information, including applications and
d ocu m ents.
Program: A series of instructions written in
tells the computer what to do and how to do
I/O: Transfer of data into a computer, and
outside world.
Flash memory; A small
of data in memory.

a computer language that
it.
from the comDuter to the

printed circuit board that holds large amounts

Laser :(light amplification through stimulated emissions of radiation)
A device that uses the oscillation of atoms or molecules between
energy levels to generate a narrow, finely focuser! beam of liqht.
Lasers are used in fiber optics, laser printeis, CD-ftM players, ind
scanners.
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2.11. Model Questions:

1, What are the basic operations performed by any computer
system?

2. Draw a block diagram of a computer? Explain the function of
various u n its,

3, Differentiate between RAM and ROM. Also distinguish between
PROM and EPROM?

4. Write about cache memory and registers?
5. Write short notes on

(a) ALU
(b) Random Access Memory (RAM)

6. Explain the significance of input, output devices in a computer.
List various input, output devices that you know?

2.12. References:

Prof.G.S.Prasad, M.Sc, M.S "Fundamentals of Computer -
Telugu Academy"

Dharma Raja Raman "Computer Primer"
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N. Subramainian "Computer Genesis' Programming &
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Lesson 3 : Computer languages and Operating system concepts

Obiectives:

The main objectives of this lesson are:

. To know the concept of software.o To understand different types of software.. To know what a language is.o To know about different types of translators,o To know what an Operating System is.o To know about Booting processo To understand various types of operating systems.r To know the basic concepts in DOS. To understand Internal and External commands.

Structure of the Lesson:

3,1. Introduction
3.2. What is software?
3.3. Computerlanguages
3,4, Translators
3.5, What is an operating system
3.6. Types of operating systems
3.7. Introduction to DOS
3.8. DOS internal commands
3.9. DOS external commands
3.10. Summary
3.11. Technical terms
3.12. Model questions
3.13. References



3.1. Introduction:

In the previous lesson we discussed about the parts and functions of

.ornputLt. It has been mentioned that programs or commands have to

be fed to the computer to do a specific task' So it is necessary to

;;;iJ" 
-i"qr"n." 

of instructions for our work to be done' we can

divide the computer components into two major areas, namely,

hardware and software.- Hlrdware is the physical components of a

computer system. Software is the set of programs'

3.z.what is Software?

As we know computers will not function without instructions from the

;;";,1"; a specific job to be accomplished we have to give a sequence

oi lnstructions to t-he computer' This set of instructions or commanos

is called a computer proiii' Software refers to a set or group of

computer programs, proc;dures that describe the programs 9nd 131
;il;;; tL t-e usea.'rie protess of software development is called

programming'

Both software and hardware have to work together to produce

meaningfuf result. To develop a software is difficult and expensive'

com puter softwa re is normal lv t':t1T:L'*t*i;i:""0 cateso ries'

. APP|ication software

System Software: System software may be defined as a set of one

oi rnot" programs designed to control the.operation of the computer

;t;";. !v.i". softwa-ie also facilitates the programming' testing'

and debugging of computer programs'

Application Software: Application Software is a set of programs to

carry out operatlons rfr'J -pecific application' For example' railway

reservation system software, hotel management software' payroll

,oft*"i", etc', Rpplicition software is useful for word processing'

billing system, 
"..orniing, 

lroducing statistical report' analysis of

nurn5rot, data in research, weather forecasting' etc'
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3.3.Computer Languages

Language is a system of communication between two people. Some of
the basic natural languages that we are familiar with are English,
Hindi, Telugu etc,. These languages are used to communicate among
various categories of people.

Computer will not understand any of the natural languages. So we
need a language to communicate with computer, There are
programming languages specially developed so that we could pass our
data and instructions to the computer to do specific job. Some of these
languages are PASCAL,FORTMN, BASIC, COBOL, C, C++, VC++ etc.
So instructions or programs are written in a particular language based
on the type of job.

Programming Languages:

There are two major types of programming languages. These are Low
Level Languages and High Level Languages. Low Level languages are
further divided in to Machine language and Assembly language.

Low Level Languages

The term low level means closeness to the way in which the machine
can understand.

Machine Language

Machine Language is the only language that can be directly understood
by the computer. It does not need any translator program. We also
call it machine code and it is written as strings of 1's (one) and 0's
(zero). When this sequence of codes is fed to the computer, it
recognizes the codes and converts it into electrical signals, For
example, a program instruction may look like this:

1011000111101
It is not an easy to learn and write. instructions in this form, Because of
the complexity very few people can write the programs in this
language. It is considered to be the first generation language.

The only advantage is that program written in machine language run
very fast because no translation is required for the CPU.



Assembly Language:

A low-level programming language that is slightly more user-friendly

than machine language, The software which translates a program

written in assembly language to machine language is called an

assembler. These are considered to be second-generation languages.

Advantages of assembly language are:
It is eisier to understand and write programs which are nearef to

English language. It saves a lot of time for the programmer, easier to

correcterrorsanomodifytheprograminstructionswhenever
necessary.

High-level Language:

These are third-generation or 3GLs, These are closer to so-called

natural languageJ(we talk)'High-level languages are simple languages

that use English and mathematical symbols like +, -, 7o, / etc. for. its

program coistruction. Any program w-ritte.n in High-level language has

io bl converted to machine'language for the computer to understand.

Higher-level languages are problem-oriented languages because the

initructions are iuitable for solving a particular problem' Choice of a
particutar high-level language depends on the application/problem'
Advantages of Hign Level Languages are easy to learn and .use
becauselhat they are similar to ihe languages used by us in our day-

to-day life.

3.4,Translators

Tra nslator:

Translator is a
la ng uage.

Assembler:

program, which converts source language to object

Assembler is a translator or converter,
language program (Mnemonics or symbols)
codi cilled machine language (0s and 1s)'

Assembler needs two passes to convert assembly language program to

machine language Program.

which converts assembly
to machine understandable



Assembly
language

Mach ine
La ng uage
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Compiler:

The programs written by the programmer in high-level language is
called source program, After this program is converted to machine
language by the compiler it is called object program.
Compiler translates the instruction of a higher-level language to
machine language. Thus compiler is a program translator like
assembler but more sophisticated. It scans the entire program first
and then translates it into machine code.

Every high-level language has its own compiler. For example
FORTRAN compiler will not compile source code written in COBOL
ra n9 ua 9e.

fnterpreter:

An interpreter is another. type of program translator used for
translating higher-level language into machine language. It takes one
statement of high-level language, translates it into machine language
and immediately executes it, Translation and execution are carried out
for each statement,
It differs from compiler in the following aspects:
Compiler translates the entire source program into machine

understandable form at a time and generates an object code which can
be used on repeated execution of the program.

With interpreter the program needs to be retranslated every time you
want the program to be executed,

3.s.What is an operating system?

Operating system is software, which is an interface between the user
rf the computer and computer hardware. . r.
Fhe following are the various operating systems: MS-DOS/ Windows
)5/98/2OOolmelNT/XP, UNIX, LINUX etc.

High Level
la nq ua qe

Machine
La ng uaqe



3.6.Types of oPeratang systems:

Basically there are two types of operating systems, single user

operating system and multi user operating system'

Sangle user operating system:
Sing-le user opirating system allows one program to execute at a time'
Thi program must completely finish executing before the next can

begin.

Multi user oPeratang systems:
A multi user-operating lystem allows a single cPU to execute what

appears to be more than one program at the same time, when' in fact

oi.,iv on" program is being executed. The cpu switches its attention

between programs as it receives requests for processing, executing

statements irom one program, and then from another' This

processing happens so fast that it appears that the number of users

exceeds the operating system's capability; noticeable delays in

processing will result.
Several other operating systems are:

Parallel System:
Some large computers may have more than -one 

processor' In. parallel

processing systems, tasks are shared between a numbers of

fro.etto.i. The operating system allocate.s instructions to eacn

fro."rtot. The more processors that are allocated to a task - the

faster that task will be comPleted

Distributed systems:
In a distributed system, computers and peripherals are linked

[og"in"i. Each user is not aware of which computer or peripheral he is

using. A user on one computer may be running a program stored. on

anot-her computer accessing data stored on yet another computer'

Here the operating system will control.access to the resources'

Real Time systems:
Real-time means that data is processed immediately, The computer

used in a real-time system is 'dedicated' - it does nothing else' An

eiatpf" of a rqal-time system is a Process-Control System' Input data

received from iensors is processed immediately, analyzed and any

necessary actions taken without any delay'



3.T.introduction to Disk Operating System [DOSI:

When the computer starts, the operating system takes control of the

machine. An Operating System is a group of programs that controls

and manages the computer Hardware and the Software resources of a

computer system.

ABOUT MS-DOS

Microsoft DOS (Disk Operating System) is a command line user

interface. MS-DO5 1.0 was rel6ased in 1981 for IBM computers and

tne tatest version of MS-DOS is MS-DOS 6.22, which was released in

t994.
o-OS operating System is used for operating the system .o'-.:h"
."rprt!-.-in"rniin functions of Dos are to mdrrdge disk files,

allocate system resources according to the requirement' DOS provides

i"utur"t required to control hardware devices such as Keyboard'

Screen, Dtsk Devices, Printers, and other progra.ms'

euri.ufiv, DoS is the interface or a medium through which the user

and external devices are communicated' DOS converts the user

commands into a computer understandable format' It also translates

the result and any error message in user understandable form'

Commands in DOS:
in"r" .t" the instructions, which are used to communicate with the

computer system. We cail these instructions are commands' The

io_'*una, of the DOS are divided into two categories: Internal

Command and External Commands

reside in a portion of the computer's
with the oPerating system into the
always available for execution. An

a command embedded into the

External Command:
These are the commanos, which haVe to be loaded from the disk into

the memory of the computer before we want to execute them' These

iommands are usually in the form of file, which reside3 in the disk, as

inA wnen required they will be loaded into memory'bdore'execution,

Internal Command:
These are the commands, which
memory and are loaded along
memory. These commands are
Internal command, which is

command.com file.
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3.8. DOS Internal Gommands:

CLS:
CLS command allows a user to clear the complete contents of the
screen and leave only a prompt,
Syntax: CLS

VOL:
VOL command displays the volume information about the designated
drive.
Syntax: VOL

VER:
VER command displays the version of MS-DOS or if running Windows
95 or above the version of Windows,
Syntax: VER

TIME:
Allows the user to view and edit the computer system time.
Syntax: TIME [time] Displays or sets the system time'
Type TIME with no parameters. Displays the current time setting and
a prompt for a new one, Press ENTER to keep the same time'

DATE:
The date command can be used to view the current date of the
computer as well as change the date,
Syntax: Displays or sets the date.

DATE [date]
Type DATE without parameters, Displays the current date setting and

a prompt for a new one. Press ENTER to keep the same date

DEL:
DEL is a command used to delete files from the memory of the
com puter.
Syntax: Deletes one or more files.

DEL [drive: ] [path]fi lename [/P]
Ex: del ramu,txt

REN:
Used to rename files ard directories from the original name to a new
name.
Syntax: REN old name new name
Ex3 REM MMU.TXT HANUMAN.TXT



CD:
CD (Change Directory) is a command used to switch directories in MS-
DOS. The Change Directory (CHDIR) or CD command enables the user
to travel around the directories in a disk. Type the CD command at the
command prompt.
Syntax: CD[drive:][Path]
CD[. . ] cd.. - Goes back one directory.
Ex: CD MAIN

cD..

DIR:
The dir command allows us to see the available files in the current and

or parent directories.
Syntax: Displays a list of files and subdirectories in a directory'

DIR [drive:][path][filename] t/Pl t/Wl [/A[[:]attributesll

/p - pauses after each screen full of information.
/w - uses wide list information.
/o - list of files in sorted order'
/l - uses lowercase letter.

Ext dirlp

COPY:
Allows the user to copy one or more files to an alternate location'
Syntax:: Copies one or more files to another location.- 

COPY t/A | /Bl source tlAl /B) [+ source l'lAl /Bl
t+ ...11 [destination] llAl lBllt/vlt/Y | /-Yl

Ex:
User can create a file using the copy command, In the below example
we create the file called "test.txt".
copy con test.bc
Once the above command has been typed in a user could type in
whatever contents he or she wishes' When you have completed
creating the file you can save and exit the file by pressing and
holding CTRL key and pressing Z key and then press enter' A

simple alternative would be pressing F6 functional key'

RD:
Removes empty directories in MS-DOS.
Syntax: Removes (deletes) a directory.

RMDIR [drive:]Path
RD [drive:]path

Ex: RD MAIN



3 9.DOS External Commands:

CHKDSK:
chkdsk is a utility, which checks thd computers hard disk drives status
for any cross-linked or any additional errors with the hard disk drive. lt
checks for the memory and gives the detailed information about the
memory consumed as well as free memory.

DISKCOPY:
The disk copy utility allows a user to copy the complete contents of a
diskette to another diskette

DOSKEY:
Doskey is a MS-DOS utility that allows a user to keep a history of
commands used on the computer, This allows frequently used

comnrands to be used without having to type the commands in each
time you need to use it.

EDIT:
Edit allows a user to view, create and or modify their computer files.

FDISK:
Fdisk allows the user to delete and/or create partitions on the hard
disk drive.

FORMAT:
Format is used to erase all of the information off of a computer
diskette or fixed drive,

LABEL:
Label is used to view or change the label of the computer disk drives.

TREE:
This command is used to display all the directories and also the files if
specified.



In this lesson we discussed about two types of software, namely,

system software and application software. It is designed for
performing tasks such as controlling all operations required to move

data into 
-and 

out of the computer. It communicates with printer, card

reader, disk, -tapes, etc. and monitors the use of various components
like memory, CPU, etc' Application software is a set of programs

written for 
-specific 

purpose. we have discussed about levels of

computer language.

In this lesson we discussed very important software component
called operating system. Operating system is system software, which

provides a linli between the usei of a computer and hardware' It
controls all the activities of the computer system' There are different
types of operating systems: single llser, multi user' parallel'

distributed and real time operating systems. In this lesson we

discussed introduction to DOS, internal and external commands'

3.lO.Summary:

3.11.Technical terms:

cpu: central processing unit of a computer, Its consists of three sub-

units: ALU - Arithmetic and Logical Unit
CU - Control Unit
MU - Memory Unit (Main memorY)

FORTRAN: FORmula TMNslation, a high
scientific and engineering applications'
MS-DOS: an operating system designed by
'IBM compatible personal computers.

resulting from the

the syntax of a

level language used for

Microsoft corporation for

Object Program: the machine language program
translation of a user(source) program.
Source program: A program written following
la ng ua9e.
firie-ihared system: A computer system with an operating system

designed to allow many users to simultaneously use it'
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3.12. Model Questions:

1. What is software and hardware? DifFerentiate application and
system software?

2. What is computer Language? Explain the three different
categories of computer languages.

3. What is a translator? Explain different types of translators or
converters?

4. What is interpreter? How does it differ from compiler?
5. What is an operating system (OS)? Explain different types OS7
6. What is booting a computer? Explain types of booting?
5. Write about DOS internal commands?
7. Write about DOS external commands?
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Lesson 4 - Windows Operating system concepts

Objectives:

At the end of the lesson the student must be able to understand

o Windows OS
. Features of windows.
o Working with windows, folders etc.

Structure of the Lesson:

4.I. Introduction
4,2. Versions of windows operating
4.3. Features of windows operating
4.4. Overview of windows Desktop
4.5. Icons on the Desktop
4.6. Parts of a window
4,7 , Mouse operations
4,8, File commands
4,9. File attributes
4.10. Special indicators in the menu
4.11. Start button
4.12. Overview of the start button
4.13. Taskbar properties
4.14. Clock settings
4,15. Shutdown menu
4,16. Find menu
4.17. Settings menu
4.18. Document folder
4.19. Programs menu
4.20. Windows explorer , ag
4.21. Screen properties
4.22. Summary
4.23. Technical terms
4.24. Model questiorrg
4.25. References.
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4.l.Introductaon

term "windows" also refers to a program that takes advantage of
computer's graphics capabilities to make the computer easier to
This is often called Graphical User Interface or GUI.

Windows 98 is an operating system (OS). An operating system is the
software that runs on your computer to control the basic operation of
your computer's hardware components such as the processor,
monitor, keyboard, mouse, memory, drives, printers, scanners, etc'
Applications such as Microsoft Word and Excel must run "on top" of the
operating system.

Microsoft windows is the popular GUI based operating system from
Microsoft Corporation, offers an excellent platform and environment
for the user. This is very user-friendly environment. Windows has
several versions windows 3.x/ 95/98/me/2000/NT/XP. Windows 95
and 98 rre single user operating systems and where as Windows NT /
servers are multi user operating system.

4.2.Features of Windows:

. Windows provides user-friendly environment.
o It is an easy-to-use, consistent Graphical User Interface

environ ment.
. It is capable of multitasking'of graphical programs and

character based programs.
. Program manager can be used to switch easily between

a

o

a

multiple programs.
Built in accessories such as wordpad and paint.
A powerful help facility is provided which will enable a
user to sort out its problems in comfortable manner.
For entertainment, window comes with some games,
Searching for specific files is very easy.
It provides multimedia related applications.

a



4.3.Overview of Windows Desktop:

When the computer is switched on, windows starts automatically. Itdisplays a login screen where the user name and password fo, usingthe network services has to be entered, on entering the correc-tpassword, the user will be able to use network service!. If the userclicks.on.cancel button, user wiil not abre to use the network se.viiei.
Then it shows the Desktop,

o" Start button

The Windows Desktop
Desktop:

The entire screen is called the desktop, It ls the first view afterentering the password in-the rogin screen. rhe picturls'o"-tn" ilrii"iare known as icons. These icoris can be arranjeo in 
"nv 

oro"iin-ir,!desktop.

Taskbar:

The rectangular bar that 
. 
runs horizontally. 3ctps9,.lh0_rbdltom of thescreen is cared raskbar. The position of th; tasiburcJn iinll."iai."to the user's requirement. IL provides 

".."rr * iiiJ iir-pi"gr";;i""iiincludes start button, current time etc.
4)



4.4.Icons on the DesktoP

Icons are small graphical images that can represent computer
programs, files, folders and printers amor]g- other things' To activate

un i.on you double click on it with the left mouse button, this will

activate the icon and either start a program or open a file/folder'

The icons on your desktop can be renamed by right clicking 9n.:19t
andse|ectingrename'simi|ar|ytheycanbedeletedbyrightc|icking
and selecting delete'

My Computer:
Thisisastandardiconand'lsveryusefu|;itcontainsa||theresources
available in the computer., Generally it consists of all the drives in the

computer, control panel, printer folder' To.change the view of the

contents in my computer, we use the various options in the vie\

menu,

My Documents:
The My Documents icon links to'a standard folder, which Windows 98

uses to store the documents' By default Windows 98 will save any

documents we create in this folder'

Internet ExPlorer:
This icon is a shortcut to
Internet ExPlorer is used to
Internet.

Microsoft's Internet Explorer program'
view web sites and web Pages on the

Network Neighborhood:
The Network Neighborhood lcon represents-a folder

to any other computers that are in workgroup'
network. neighborhood are workgroups' r servers'
printers.

Recycle Bin:
nll files and folders, which are deleted from the windows, are stored in

in" ."ivif" bin. By default windows 98 is setup to deposit all deleted

iii"., roia".t or icons in the recycle bin' Recycle bin can be used to

restore files that have been deleted'

that contains links
The contents of

share folder and
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4.s.Parts of a Window:

Every program window looks
menus, icons, and controls.

Windows has Title bar,
Maxim izelrestore box, Close

Menu bar

a little different because each has its own

Control menu, Minimize box,
button, Status bar, lvlenu bar.

Iihxlml:N
TUc bat Minimize

Closr

..h..|k..'*e4.?.d

Crmprirr
a@(' -\*qi
Se**'*:-

jil

Tool bar

AddrGs bf

*.irll&t|3*.1:

Cfose Bufton: Click the Ctose button to close the active window
or program.
Menu Button: Consists of a set of keywords (control words) for
this window.
Status Bar: Shows the comment on selected item.
Menu bar:Window menu is a list of commands that you can
select. Click a menu bar item to perform a command in a
pro9 ra m.

$aaF btr



4.6.Mouse operations.

The mouse is used to move around and activate different

features of Windows applications in the following manner

Click:
Press and release the left button on the mouse'
Right Click:
Point the mouse and.then clicking the right button
to display the short-cut menu for that item.
Double click:
Point the mouse to
rapidly.
This is used to start

an item of choice and click the left button twice,

programs and oPen files,
Drag & DroP:
ioiioo*n ine tert mouse button of the mouse while you are

moving the mouse and release it at the desired position'

4.7.File Commands:

Copying:
Copying files to another
files to be copied, hold
destination.

Moving:
Move the files to another
then drag them asa group

directory or drive. Select explorer: Select the
the ctrl key, and Drag the selection to the

directory. Select the files to be moved and

to the new destination.

Deleting:
o"r"G, 

-selected files. select the files and press Del or File Delete,

Delete dialog box appears showing the current.directory and the name

ottn" rit" to-be deleted. click on ies button, The deleted files are sent

to recycle bin.

Renamang:
i"nurno. ielected files. select the item to be renamed, choose File -,>

Rename, Current name get selected, and Type the new name' Press

enter or click outside the file name'



4.8.File Attributes:

Select the files whose attributes you want to alter, Choose File ->
Properties then Properties Dialog box appears, check the boxes
appropriately. The attributes are:

Read only: Does not allow any one to make any cnanges

Archive: Indicates the file has been modified since the
This is used by backup program such as the
commano.

4.9.Special Indicators in Menu:

to the file.

last backup.
DOS backup

Hidden: Hides the file from the directory listing in Dos and directory
Windows in the explorer.

System! To tell windows that it is an Operating,system file. Move the
mouse pointer to the menu item in the menu bar and then click on it,

Closing menu: Click on the Menu or anywhere outside the menu,
Choosing a menu item, Click on the items usinq mouse.

Window menu often have special symbols that tell you more
about Menu Commands, They are

Ellioses(...) : If the window or window apprication requires moreinformation from your end before the execution of a particurar
command, the names of such commands shall be followed by Lllipses.

Trianglej )'lr A triangle preceding the command has additional sub-choices for you to be made. Selecting such command brings up a
cascading menu with more options to chosen from,

gption bqttons( ''l: There are exclusive settings.,They are round
boxes, and only one can be set on at a time. io seteit an option
button cliCk on the option button.



4.lo.The start Button:

The Start button is the single most commonly used feature in

windows. . This button is the primary thing of
starting programs from the desktop. This is a

very important part of Windows. Using the Start
button you can start Programs, open
documents, customize your system, get help,
search for items on your computer, and more'

To open a start menu item, first click Start. The
start menu opens showing you the first level of
menu items. When you move the mouse pointer
over any menu item that has an arrow next to
it, another menu, or submenu, opens ancl

reveals related files, programs, or commanos.
Click on a file or program to open it. The Start
Button gives you access to programs that you
have loaded on the computer. It also lets you
access common tools that come with Windows.

4.1l.Overvaew of the Start menu:

Programs:
This-section of the Start Menu holds all of the program groups and

programs installed on your machine. You can open the programs menu

by pointing to it with the mouse'

Favorites:
This Folder keeps track of your favorite files: games, programs, weD-

sites,younameit.Clickonanyiteminthelisttoautomaticallygo
there.

Documents:
The Documents section contains the last
on. By clicking on a document name, the
the program that was used to create it.

Settings:

few documents You worked
document will be opened in



The settings section enables you to change the settings and basic
appearance of Windows 98,
Find:
Use the Find feature to search a drive, multiple drives, or your entire
system (including networked drives) for a folder or file you are
searching for.

Help
Help starts the Windows 98 help program. This program can also be
accessed by pressing F1. See the Help section for more information

Run
Run can be used to start a program on your hard drive or on a floppy
disk, To staft a program, either type in the name of the program, or
choose Browse to select the file to run

Log Off
Use this feature if you want to log off your system and allow someone
else to log on without running through a complete shut down of the
system.

Shutdown
The Shutdown menu will allow you to turn the computer off or reboot
your system as you choose.

4. l2.Taskbar Properties:

Click the start button. Put to setting on
Sta rt menu.
On the setting menu click on the
Taskbar,
Select the Taskbar options tab.
You can change the following settings,
using the options tab.

. Always on top
o Auto Hide
. Show small icons in Start menu
. Show clock



tbr Distance Educati

4.13.The Clock - Setting The Date and Time:

If the date or time is incorrect, right click on the clock and select

adjust date/time.

!t'
lffiI ltt-t

l, 4rcnrd)<!*{4-di r|id jd d.ldr rl.rrgd)-t

properties can be found in
Contro I Panel.

Select the correct Year, month ancl

day from the calendar area on the
left side of the window. On the text

r box, which disPlaYs the digital
clock, using the left mouse button,
single click to Place the cursor In

! the area which is incorrect, hh,

mm, ssf am/pm.

I Use the scroll areas to the right to
increase or decrease the time,
which ever is aPPlicable When the

date and time is correct, Press the
OK button to exit. Other clock

the Regional Settings option found in the

4,14.The Shutdown menu:

We should never just turn off the computer' To avoid damage to the

;;;;;; tois oriites, alwavs follow specific.ste-Ps to shut down the

computer. The Start,nen, it where you begin the shutdown process'

it has several oPtions they are:

Shuts 'lown the PC, always use this
option lo turn off Your Pc.

Resta rt:
What do you wad tht cwputer to do?

" !!]|-9.!I!
a B6rad

a FertottinUS-D0S mode

l0 f oK-l cancer I lt-l
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This will restart the computer.
Restart in MS-DOS Mode:
This will cause the PC to restart in the MS-DOS environment.

4.1s.The Find menu:

N lib:utulJur

4 lmprr,T

lJf ryf filefNl.

Files or Folders
This is used to search for files or folders on your
PC (see related pages at top of this page for a
guide).
Computer

It
This is used to find
On the Internet
This will search the

computers on you r network.

Internet for your query.

$ !,'$t People
This will search your PC and otner sources for
people.

4.16.The Settings Menu:

-sl

$
]J

u
t

ladrd Prrd

!n*er.r

laekbr & 9toil Monr".

fdds 0ptirs..

Acti'l'De*top

Control Panel - The control panel is used to
configure Windows 98.
Printers - Used to add and configure printers.
Taskbar & Start Menu - Here you can
customise your taskbar & start menu.
Folder Options - Here you can change the look
and feel of your folders,
Active Desktop - Changes the desktop
settings.
WindoWs Update - starts the automated

windows u pd ate.

4.L7.The Documents folder:

This acts like a folder, it will contain
viewed documents for fast access as
the main My Documents folder.

the recently
well as a link to
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4.l8.The Programs Menu:

To open a program simply left click on it, as with the start menu the
options with the small black arrow to the right 1,o Accessobs

hand side contains another sub menu. For i5 eo,*

example if you wanted to open a program in the 3 Ev.ofi

accessories folder, then you would hover the 13 er*rscapr

mouse over accessones and then click on the e J'sc sdtwd"

program you want from the sub menu that H ;":1X'i:1-,
appeafs. a MbDsdt 0rlto loots

':-3j onle Sr;ees

You can rename any program on the menu by l-i stotup

right clicking on it and selecting rename from the g ::y
menu that appears. ,i ffi

,j Zo'" r-or"

Whenever you install software it will (normally) 1i] a'oe a"ua.' ao

appear on the programs menu, if you ever want 3 taanae@er

to remove a program then use the control panel lEil MsrosdtPc^t€iPo^t

to uninstail it, simply deleting it from the I m:'y;l
programs menu will not uninstall the software.

)

l

t

tlo 1,5.

4.19.What is Windows ExPlorer?

Windows Explorer is a file
management program similar to
File Manager in Windows 3.1. It
allows customers to move or coPY
files from one folder or drive to
another, and to safelY delete files
by sending them to the recycle
bin. In add ition, Windows
Explorer allows you to view Web
pages directly in the window.

Windowsg8 separates the window
into two panes. If you click on an
object in the left Pane, the
contents of the object disPlaYs in

Ei. la Yie Eo

:'.1'-a
-....!JfL-..'..'

- a, r,ry c*w.
. j, lhFtopvlaj

:- I @+iore
J n3td

I |@6

I ^m$rn4.l
r __l 1552 5
i ._l aoobr3
, __l a!

J 86r!0
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.ll
liit;r{;i -
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the right pane. Click on Desktop and the contents of the Desktop
folder display on the right. Click on My Computer and your computer
resources are displayed on the right. To see the contents of a drive,
click on the drive. To see the contents of a folder, click on the icon for
the folder in the left pane.

4.2O.Screen Properties:

To change or access options for the "look" of the desktop, right click
on the desktop area. This area should be free of icons. From the quick
menu, which appears, select "Properties".

Background:
The background options allows your desktop to have fancy patterns
and wallpaper for your viewing pleasure,

Screen Savers:
It provides some thing to do while the computer is idle, If the
computer is idle for a set period of time, the screen saver will
automatically begin, To stop the screen $aver, simply move the
mouse, or press any key on the keyboar will offer some security
features (Password) also.

Appearance:
The appearance option is used to set the system colors for items such
as desktop background, title bars, menus etc. Use caution when
selecting colors to ensure visibility of text.

Settings:
The settings option is used to change the viewing area of the desktop,
setting font size, and size of the desktop area. These settings can
control one monitor in Windows'95, and two monitors in Windows'9g,
They should only be changed by experienced users.



4,21.Summary:

In this lesson we discussed different type of operating system
including windows 3.x/95/98/NTlXP. Windows is a popular Graphical
user interface (GUI) based operating system from Microsoft
Corporation, offe rs an excellent platform and environment for the user.

It provides user-friendly environment.

Windows desktop contains several components, icons, start ,button'
Every action should be starting from the start button. We have

discussed the start button items, parts of a window, and screen
properties like changing desktop wallpaper, screen saver windows
explorer and its comPone 's.

4.22.Technical Terms:

GUI: Systems
visible objects

software that allows users to have direct control of the
such as icons and actions that replace command syntax'

Multitasking: The operation of two or more programs running on a

single processor (CPU) at the same time.

Icon: An icon is a small object used to remind the user of a particular

operation, idea or a Project.

Wandow Operating system: An operating system from Microsoft, in
a variety of products, that provides a GUI using icons to provide

instant access to common task,

Taskbar: A bafi ^on the $raphic user interface that shows all open

applications and active windows, Clicking any task button on the

taskbar brings the corresponding session to the foreground"



Shutdown! The term "shut down,' can be used to mean, "turning pff,,
something, but most commonly used for computers.

4.23.Model Questions:

1. What is windows operating system? Explain its features?
2. Explain the parts of a window?
3. Write about windows explorer?
4. Give overview of start button?
5. Write about file commands and attributes in windows?

4.24.References:

Alexis Leon & Mathews Leon ..Fundamentals of Information
Technology".

A.Jaiswal "Fundamentals of computers and Information

:::T*tJ. ..workins in Microsoft orrice,;. rata McGraw Hir.

Sharon Crawford and Neil J.Salkind ..ABC of Windows 98- , BpB
publications.

AUTHOR:
G.RAMANJAIAH., M.Sc(Com puters)
lectur€r, Dept,Of Compgter Science,
JKC College, :
GUNTUR.



Lesson 5 - Microsoft Office and Word Processing

Objectives:

This lesson provides an introduction to the Microsoft Office. It covers
Microsoft Office Products, introduction to Word-Processing and features
of Word-Processing.

Structure of the Lesson:'

5,1. Introduction to Microsoft Office

5.2. Word-Proces'' rg

5.2. Features of word-Processing

5.3. Summary

5.4. Technical Terms

5,5. Model Questions

5,6. References
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5.1. Introductaon to MS-OFFIGE:

Microsoft Office for windows is a suite of applications that are also
available as independent programs. Microsoft Office is a major facility in
computer applications field, Microsoft Office comes in two ways. One is
called Standard and other one is called Professional. Both the
versions have the following primary applications,

1. Microsoft Word

2. Microsoft Excel

3. Microsoft PowerPoint

4. Microsoft Access

5. Microsoft Mail

6. Microsoft Graph

7. Microsoft Clip Art Gallery

8. Microsoft Word Art.

9. Microsoft Organization Chart

10. Microsoft Equation Editor

11. Microsoft Publisher

Microsoft Word

This is a full-featured word processor that can create letters, menus,
reports, newsletters, manuals and any kind of documents. You can use
it for daily correspondence and desktop publishing also. It is having
more menus, keyboard shortcuts and toolbars. Toolbars containing
buttons that you can click to perform, common tasks like centering text,
saving and printing documents, After developing our own working style
we can make custom toolbars, Word provides macro capability to do
repetitive tasks. It provides some model reports called templates,
rather than typing all the matters it gives skeleton reports. Wizards are



more powerful than templates. Word having spell checker that checks

the document and more features like Auto formatting, Printing envelops
and labels, Mail Merge.

Microsoft Excel

This is a spreadsheet program that allows you to organize, analyze
information. It is designed to work with numbers. You can enter data in
cells arranged horizontal rows and vertical columns on work sheets.
Excel organizes the worksheets with workbook. Every workbook having
3 (default) worksheets and you can add up to 255 worksheets and
you can remove 1 or 2 worksheets from the three' Worksheets contains
65,536 rows and 256 columns (numbered A to IV)'.The address of the
cell is combination of row and column labels. Excel provides tool bars,
menu choices and functions. Other than these features excel provides
Screen wizard, autocalc, auto complete, templates, templates wizard etc

Microsoft PowerPoint

It is a presentation tool. We can create slides, handouts and speaker
notes. The slides can be arranged sequentially in presentations'

Microsoft Access

This is a powerful database program but you can store, retrieve, and

organize data, Access comes with wizards and variety of predefined

database elements,

Microsoft Mail

Microsoft Mail is a product that comeS,with a license to use mail on the
workstation w.here office h installed. If your workgroup is using

Microsoft Mail, thb*bndp allcw's to copy the necessary software to your
machine.



Microsoft Graph

Microsoft Graph is used to convert the tabular as well as text data into
the graphs and charts. A number of graphs and chart options are
provided by this component of Office,

Microsoft Clip Art Gallery

Clip Art Grllery is a collection of ready-made graphics that the user can
import into any of the primary applications to make them more
effective.

Microsoft Word Art
Word Aft enables a user to convert the text into various shapes for
logos, banners, and headlines.

Macrosoft Organization Chart

Microsoft organization chart provides the tools for creating figures such
as organization charts by selecting the different styles and organizations
for charts.

Microsoft Equation Editor

Microsoft Equation Editor enables a user to format complex equations
correctly.

Microsoft Publisher

It helps to organize the material of textbooks in the form of chapters
and volumes.
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5.2. Word Processing:

Using a computer to create, edit, and print documents is called word
processing. Of all computer applications, word processing is the most
common. To perform word processing, you need a computer, a special
program called a word processor and a printer. A word processor
enables you to create a document, store it electronically on a disk,
display it on a screen, modify it by entering commands and characters
from the keyboard and print it on a printer.

The great advantage of word processing over using a typewriter is that
you can make changes without retyping the entire document. If you
make a typing mistake, you simply back up the cursor and correct your
mistake. If you want to delete a paragraph, you simply remove it,
without leaving a trace. It is equally easy to insert a word, sentence, or
paragraph in the middle of a document. Word processors also make it
easy to move sections of text from one place to another within a
document, or between documents. When you have made all the
changes you want, you can send the file to a printer to get a hardcopy,

5.3. Features of word processing:

Insert text: Allows you to insert text anywhere in the document.

Delete text: Allows you to erase characters, words, lines, or pages as
easily as you can erase them on a black board,

ut and paste: Allows you to remove (cut) a section of text from one
lace in a document and insert (paste) it somewhere else.

Cgpy:.Allows you to duplicate a section of text.

Page size and margins: Allows you to define various page sizes and
margins, and the wor.l processor will automatically readjust the text so
that it fits.

Search and replace: Allows you to direct the word processor to search
for a particular word or phrase, You can also direct the word processor
to replace one group of characters with another everywhere that the
first group appears,
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Word wrap: The word processor automatically moves to the next line
when you have filled one line with text, and it will readjust text if you
change the margins.

Print: Allows you to send a document to a printer to get hardcopy.

File management: Many word processors contain file management
capabilities that allow you to create, delete, move, and search for files.

Font specifications: Allows you to change fonts within a document.
For example, you can specify bold, italics, and underlining. Most word
processors also let you change the font size and even the typeface.

Footnotes aiid cross-references: Automates the numbering and
placement of footnotes and enables you to easily cross-reference other
sections of the docu ment,

Graphics: Allows you to embed illustrations and graphs into a
document. Some word processors let you create the illustrations within
the word processor; others let you insert an illustration produced by a
different program.

Headers, footers, and page numbering: Allows you to specify
customized headers and footers that the word Drocessor will put at the
top and bottom of every page, The word processor automatically keeps
tr€ck of page numbers so that the correct number appears on each
page.

Layout: Allows you to specify different margins within a single
document and to specify various methods for indenting paragraphs.

Macros: A macro is a character or word that represents a series of
keystrokes. The keystrokes can represent text or commands. The ability
to define macros allows you to save yourself a lot of time by replacing
common combinations of keystrokes.

Merges: Allows you to merge text from one file into another file, This is
particularly useful for generating many files that have the same format
but different data. Generating mailing labels is the classic example of
using merges

Spell checker: A utility that allows'you to check the spelling of words.
It will highlight words that it does not recognize.

Table of contents and index: Allows you to automatically create a
table of contents a.nd index based on special codes that you insert in the
locu ment.
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Thesaurus: A built-in thesaurus that allows you to search for synonyms
without leaving the word pr^cessor.

Windows: Allows you to edit two or more documents at the same time.
Each document appears in a separate window. This is particularly
valuable when working on a large project that consists of several
different files.

WYSIWYG (What You See Is What You Get): With WySIWyG, a
document appears on the display screen exactly as it will look when
orinted.

5.3.Summary:

At the end of this lesson you have learnt the importance of Microsoft
Office products and important features of Word Processing. In all the
MS-Office products, the familiar products are MS Word, MS Excel, MS
PowerPoint and MS Access. Word processor enables you to create a
document, store it electronically on a disk, display it on a screen, modify
it by entering commands and characters from the keyboard and print it
on a printer.

5.4. Technical Terms:

Cut and paste: Allows you to remove (cut) a section of text from one
place in a document and insert (paste) it somewhere else.

Copy: Allows you to duplicate a section of text.

WYSIWYG: What You See Is What You Get.

Spell checkerr A utility that allows you to check the spelling of words.

Word wrap: 'fhe word processor automatically moves to the next line
when you have filled one line with text, and it will readjust text if you
change the margins.



5.5. Model Questions:

l.

2.

Explain in detail about Ms-Office

Define Word-Processing? Explain the features of Word Processing?

5.6. Referencesl

RON MANSFIELD,'Working with MS OFFICE', Tata Mc Graw Hill - 2000
Edition

GUY HART DAVIS, ' The ABC'S Of Microsoft Offace. . BpB
Publications, New Delhi

MS OFFICE 2OOO Gomplete, BPB Publications, New Delhi

AUTHOR:
Y. SURESH BABU,
Lecturer,
Dept.Of Gomputer
JKC College,
GUNTUR.

M.Com., M.C.A.,

Science,



Lesson6-MicrosoftWord

Objectives:

This lesson provides an introduction to the fundamentals of Microsoft
Word. It covers starting Word, the Word interface, creating a Word
document, editing a Word document, selection techniques, text
formatting, page setup and print documents.

Structu re of the Lesson:

6.1. Starting word and components of word window
6.2. Creating and saving a document
6.3. Adding & modifying text
6.4. Selecting Text
6.5. Cut, Copy and Paste Text
6.6. Paste Special
6.7. Find and RePlace
6.8. Redo and Undo
6.9. Formatting Text & ParagraPhs
6.10. Header and Footer
6.11. Bullets and Numbering
6.12. Zooming
6.13. Page Break
6.14. Auto Correct and Auto Text
6.15. Page Setup
5.16. Print Preview and Printing
6.17. Summary
6,18, Technical Terms
6.19. Model Questions
6.20. References
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6.1. Getting Stafted with ltlicrosoft Word:

Starting Word
On the PC, select Start followed by

fa|nabe Siribd
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Programs, and Microsoft Word from
the Start list.
Components of the Word Window
Besides the usual PC window components (close box, title bar, scroll
bars, etc,), a Word window has other elements, as shown in the
following figure.

Ihdorl g|rto|!.
Cb.. l|h&..
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Component Functionality or Purpose of the Component

Menu Bar Contains File, Edit, View, Insert, Format, Tools,
Table, Window and Help menus.
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Standard Toolbar Contains icons for shortcuts to menu commands.

Formatting Tool Bar Contains pop-up menus for style, font, and font
size; icons for boldface, italic, and underline;
alignment icons; number and bullet list icons;
indention icons, the border icon, highlight, and font
color icons.

Ru ler Ruler on which you can set tabs, paragraph
alignment, and other formats.

Insertion Point Blinking vertical bar that indicates where text you
type will be inserted. Don't confuse the insertion
point with the mouse I-beam. To move the
insertion point, just click the mouse where you
want the ooint moved.

End-of-File Marker Non-printing symbol that marks the end of the file.
You cannot lnsert text after this mark.

Selection Bar
(Gutter)

Invisible narrow strip along the left edge of the
window, Your mouse pointer changes to a right-
pointing arrow when it is in this area. It is used to
select a line, a paragraph, or the entire document.

Split Handle Double-click to split the window in two (to view
different portions of the same file). Double-click to
return to one window

Status Bar Displays page number, section number, and total
number of pages, pointer position on page and
time of day.

Task Pane Displays and groups. commonly used features for
convenience.

Office Assistant An animated
suggestions.
choose from,
Assistant off.

character that can provide help and
There are multiple charaiters to
and it is possible to turn the Office
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6.2. Creating and Saving a Document:

Opening and Closing A Document

To open a file, select Open... from the File menu. In the dialog box, click
on the filename and then on the Open button, If your file is not in the
opened folder, click on the down arrow (next to folder name) to see a
directory listing. The Up One Level button icon on the right enables you
to move up one level. You can then switch to the flopny disk, hard drive
or Deskt.^ where the appropriate file or folder is locareo.

- , a r{ {:;, -. rl'*.

;

l, l\r.l.i

Figure 6.2

For example, to open a file from a floppy disk, select Open... from
the File menu. If the disk's name does not appear on the left side of
the dialog box, click on the down arrow. Select its name in the box at
the left or if it is not displayed, click the Up One Level button to see a
different display of files and folders, When you locate the desired
diskette or file, click Open. (Double-clicking on the name will also
.open it).

To close a document, click its close box in the upper right of the title bar
(box with the large X on it) or select Close from the File menu, The
keyboard shortcut is <Ctrl + W>.



Saving a Document

Saving means preserve the content in a Secondary Storage device. It is

a good idea to save your document right away and they continue saving
evlry 5 or 10 minutes so if your computer crashes you will not be losing

much. Your document and changes you make to a document are not
saved to disk until you issue a save command. Saving is quick and easy'
You should save often to minimize the loss of your work. Word has two
save commands - Save and Save As' - that work similarly. Both are
u nder the File menu.

hen vou save a new oocu
the first time, Word disPlaYs

ialog box. Select where You wa
save your document and give
name. When you save a

sting document that You
n editing, the newlY sav

ersion is written over the olde
ersion.

6.3. Adding and ModifYing Text

Entering Text

To enter text, just start typing. Word inserts the text you type at the
insertion point. If you press a wrong key, use the Delete key to erase

the mistake. Word automatically sta rts a new line when you reach the
end of the current line, This is called "word wrap"' Do not press Enter at
the end of a line. Press Enter only at the end of paragraphs.
For typing a paragraph follow the procedure given below:

Remember, don't press Enter at the end of the line'

To move the insertion point with the mouse, click the mouse in the
desired location. If the location you want is not visible, use the scroll

bars to move up or down in the document. To move the insertion point



to the top of the document, press <Ctrl + Home>. To move to the end
ofthe document, press < Ctrl + End >.
To insert new text, just click the mouse at the point where you want to
insert the additional text and start typing. Existing text moves to
accommodate your additions.

Type <Ctrl + Home> to move to the very beginning of your document.

Deletang Text

The Backspace key deletes one character to the left of the insertion
point. The Delete key deletes one character to the right of the insertion
point. You can use these keys any time. To delete more than just a few
characters, select the text and press the Delete key.

Undoing Mistakes

If you have accidentally deleted an important paragraph, use the Undo
command under the Edit menu immediatel)' (The keyboard shortcut is
< Ctrl + Z >). The deleted portion of th€ text is brought back. This
command can bring back the deleted contents only if you have not
pressed any other key in between.

6.4. Selecting Text:

You select a portion of text in order to perform some operation on it.
You can then delete, replace, copy, move, or format it. The Selection
Bar is located to the left of the document window. When you put your
mouse poihter, which is a left pointing arrow in that area, the arrow
swings to the right. The following table gives the process of selection of
text contents,
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To Select...

ord Double click anywhere on the word.

ne Click right-pointing arrow in the selection bar to left of
line.

tence <Ctrl + click> anywhere in sentence.

Pa rag ra ph
Double-click the right-pointing arrow in the selection
bar to the left of the paragraph, or triple-click in
paragraph.

block of text of
ny size

Click at one end of the block and shift-click at the
other end of the block. Or click at one end of block
and drag to the other end of the block.

Entire docu ment Press < Ctrl + A> or hold down the Ctrl key and click
in the selection bar,

lect text Click rhere outside the selection.

lExtend a selection

.

Shift-click an additional block. For example, if you
have selected a paragraph and you shift-click on
another paragraph, it will be added to the selection.

6.5. Gut, Copy and Paste Text:

You can copy selected text from one place to another with the Copy and
Paste commands.

Cut - The Cut command extracts the selected text and puts it on the
Clipboard (a temporary storage area). The contents of the Clipboard are
overwritten with each copy or cut. This can be done either by selecting
Edit from the menu bar and opting the cut option in it. Alternative usage
of the short cut key is CTRL +X.

copy - The Copy commAnd puts e copy of the selected text on the
Clipboard. By selecting the Edit from the menu bar and opting the Copy
option in it. Alternabive is4lsage of the short cut key is CTRL + C.



Paste - The Paste command inserts the Clipboard,s contents at the
insertion point. The text that has been selected using Cut/ Copy
command will be pasted at the insertion point. Existing text moves io
accommodate pasted text. By selecting the Edit from the menu bar and
opting the Paste option in it. Alternative usage of the short cut key is
CTRL + V.

6.6. Paste Special:

Paste Special is a way to paste information from one
application/document to another. The paste Special dialog box allows
you to paste information in different ways. Choose paste Special from
the Edit Menu.

You can paste in the information in several ways:

Formatted Text, Unfoimatted Text, picture Object.

When we paste Formatted Text, it will paste all formatting (such as
Bold, etc.) along with the text. When we use paste Special option the
formatted text can be pasted as unformatted text or an object.

6,7. Find and Replace:

Word allows us or helps us to search for a word in a document

Find: Find is used for searching a word in your document,
1.On the Edit menu, click Find.
2.In the Find what box, enter the text that you want to search for.

Replace: Replace is used to replace the searched word by another text.
Click On the Edit menu, click Replace.
In the Find what box, enter the text that you want to search for.
In the Replace with box, enter the replacement text.
The other options you have are Replace, Replace All, Find Next and
Cancel.
Replace button replaces a word selected, at the first.occurrence of the
word in your document after the insertion point.
Replace All button repraces ail the searched words in your document.



-Find Next button searches for the next occurrence of the word being
n 
searched,
Cancel button cancels the search process.

6.8. undo and Redo:

Undo
WhenworkinginMicrosoftWordyouwi||oftencommitmistakes'
Instead of ma-nually trying to undo these actions you are able to. rectify

the mistake just by'clicking the Undo buttdn on the standard toolbar.

To practice the Undo Feature:
1) iress CTRL +End to move to the end of the document
2) Highlight the last paragraph in the document
3) Press the Delete key on the keyboard
To Undo the Previous Action:
Click the Undo button on the Standard Toolbar

Redo
You may accidentally clicx Undo too many times and thus, need to redo

it. This command works exactly in the reverse of Undo command'
To Redo the Previous Action:
Click the Redo button on the Standard Toolbar
Save and close the file.

6.9. Formatting Text and Paragraph

Microsoft word allows you to format.a document very easily. without
formatting, a document looks very plain and may not get the attention

that is desired.
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Making Font Changes
In Microsoft Word you are able to change the font size, color, type and
attributes. Below we demonstrate various ways to change the font.

Select a document of unformatted text for formattinq.
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To edit the font style

1) Highlight the paragraph
2) Select Format menu
3) Select a Font type.
4) Notice the Preview window at the bottOm of the dialog box, which
displays the style of the font, selected.
5) Click OK

Font Size

Opting the one of the numbers in size box does changing the font size
for a selected portion of the text.

Using Bold, Italics and Underline

Another way to make text stand out in a document is by using bold,
italics and underline (or a combination of these) formatting.

To Bold Tt-xt in a Document

1) Select any word(s) in the document
2) Click the Bold icon on the Formatting Toolbar

To Italicize TelC in a Document

1) Select any word(s) in the document
2) Click the ltalic icon on the Formatting Toolbat

To Underline Text an a Document

1) Select any word(s) in the document
2) Click the Underline icon on the Forrnatting Toolbar

Formatting Paragraphs

In Microsoft Word, a paragraph is any amount of text followed by a
paragraph symbol (!l). A one-word heading is a paragraph' A 10O-word
job description is a paragraph. Even a blank line terminated by a fl is a
paragrapn.

You can perform paragraph formatting from the Format menu.
Highlight the paragraph you want to format.
Click on Format from the Command menu.
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r4ake the changes from the options that are displayed in
=or example, to change line spacing from single to double,
Line spacing drop down arrow, and choose double. you can
f,ptions from the Formatting Tool Bar to format paragraphs,
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6.10. Header and Footer

A header or footer is text or other information such as graphics that is
stored at the top or bottom of the page throughout your document. you
can use the same header and footer throughout a document or change
for part of the document, For example, you can use your corporate logo
in the first-page header, and then include the document,s file name in
the header for subsequent pages.

To view Headers and Footers in Normal View, click View > Header ano
=ooter. If you are in Page Layout View (Word 97) or print t avout View

le
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(Word 2000), simply double click the visible header or footer tha
appears as g ray text.

In either case, the Header/Footer toolbar appears.
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Figure 6.10

6.11. Bullets and Numbering:

Word has a feature of giving automatic numbers and bullets for
paragraphs or for points. For bullets fist select the paragraph or points
to be bulleted and then select bullets icon form the standard toolbar or
select Format from menu bar and opt for Bullets and numbering. Select
different types of symbols as bullets.

6.12. Zooming:

The level of magnification of the text can be controlled by this zooming
control. Choose percentage value from the zoom popup menu and size
of maonification of text.

6.13. Page Break:

After allowing certain number of lines MS Word automatically inserts a
dotted line in the document called page break. We can insert a page
break at any line in the document. Select Insert Menu from menu bar
and click break. Now the page break dialog box appears. Here select



page break button
thgcurrent cu rsor

and click on it. Then
position.

page break will be inserted at

6.14. Auto Correct and Auto Text:

Auto Correct

Auto Correct is used to correct the repeated typing mistakes. Select
Tools menu from the menu bar and click Auto Correct option, then
activate Auto correct tab, Here type frequently misspelled words in
'Replace box' and the correct one's in 'with box'. Click the Add button to
add this to the dictionary. Afterwards if we misspell a word, which was
added to the dictionary, .word will automatically correct the mistake.

Auto Text

Frequently typed text can be placed into an Auto Text entry. First type
the text what we want to put into an Auto Text entry and then select it,
Select Tools menu and Click Auto Correct and then activate Auto Text
Tab. Now, enter the abbreviation for the selected text and click OK.
Afterwards, if we want to type the text that is there in the Auto Text,
simply type the abbreviation and click OK. Then automatically the text
will be typed without actually typing.

5.15. Page Setup:

Page Margins

The page margins of the document can be changed using the rulers on
the page and the Page Setup window. The ruler method is discussed,
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Figure 6.15a

first move the mouse over the area where the white ruler chanoes to
gray.

When the cursor becomes a double-ended arrow, click with the mouse
and drag the margin indicator to the desired location. Release the
mouse urhen the margin is set,
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Figure 6.15b

The margins can also be changed using the Page Setup dialog box:
Select File/Page Setup and choose the Margins tab in the dialog box.

Enter margin values in the Top, Bottom, Left, and Right boxes. The
Preview window will reflect the changes. If the document has Headers
and/or Footers, the distance this text appears from the edge of the page
can be changed. Click OK when finished.

rage Size and Orientation



Change the orientation page within the page Setup dialog box.
Select File/Page Setup and chocse the paper Size tab.

Bargint
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cancel I

Figure 6.15c

Select the proper paper size from the drop-down menu.
Change the orientation from poftrait or Landscape by checking the
correspondi.ttg rad io button.

Page Numbers

Follow these instructions to add page numbers to a oocument.
Select Insert/Page numbers from the menu bar and the folrowing dialog
box will appear.
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Select the position of the page numbers by choosing "Top of page" or
"Bottom of page" from the Position drop-down menu. Select the
alignment of the page numbers in the Alignment drop-down menu' If
you do not want the page number to show on the first page (if it is a
title page, for example), uncheck the Show number of first page box'
Click OK when finished.

6.16. Print Preview and Printing:

preview vour document by clicking the Print Preview button on the
standard toolbar or by selecting File/Print Preview. when the document
is ready to print, click the Print button from the Print Preview screen or

select File lPrint.

OK



6.17.Summary:

At -the end of this lesson you have rearnt the important features of Ms-word' we started with procedure to invoke Ms-word. we have identified
toolbars available in the word. you rearnt the procedure of creating anew document and opening an existing document. Now you are ii aposition to create a new document and can make corrections rike
dgleting a character, word, rine or paragraph and reprace with requiieJ
text by using replace option. you can arso move the serected part of thetext to another place by the\cut,. and .'paste,, commands. At the end ofthe lesson we discussed the procedure of saving a document and exitfrom word,

Yo,u have gained the *no.wledle of formatting a document using
different formatting optiofis rike setting margins, changing the font size]
and alignment to the text;, The header!, fooiers, tabs, indLnts make the
document in presentable format.

6.18. Technical Terms:

Font

Font refers to the combination of a typeface (eg. Times
Century Schoolbook) and its attribut# (bold, italics, size

Roman, A6ial,
(12pts).

Bullets

Bullets are speciar characters or symbors that are used to set off aparagraph. Typically, each. bulleted paragraph is an item in a list, and it
:9n:ist: of the bullet symbol and indenting to set the bullet 

"p".t 
fromthe text.

DoCument

A document is any data file that is Created by a specific application.



Current Document

The current, or active document is the document you see on the Word

screen,

Drag-and-drop

Drag-and-drop is a feature that allows you to move or copy information
without using the Windows Clipboard. To use it, you simply drag a
selected item from one location to another. It is best used for moving or
copying small items short distances.

Footer

\ Footer is the contents of an area located within the bottom margin of
r page,

leader

, header is the contents of an area located within the top margin of a
a9e.

,ustificataon

Justification determines how lines and characters within those lines are
printed, With full justification, all lines start at the left margin and end

at the right margin,

Margin

The margin is the amount of blank space, usually measured in inches or
characteis, above and below and to the right and left of the main body

of a document,

Menu Bar

The menu bar contains the names of Word's menus and is used to
navigate through their commands'

Paragraph

A paragraph in Word begins
you press IENTER].

where you start typing, and it ends where



5.19. Model Questions:

1. Explain about different components of MS-Word window'

2. Explain Find, Replace & Go To?

3. Explain Header and Footer?

4. What is the difference between Auto Correct and Auto Text

5. Explain the text formatting features in MS-Worcl
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Lesson 7- Microsoft Word

Objectaves:

This lesson provides an introduction to the Views, Spell Checking,
Tables, Macros and Mail merge,

Structure of the Lesson:

7.1. Views
7.2. Spell Checker

_.7,3. Word Count
71..4. Macro
Tiitraphics
7.6. Lines and Shapes
7.7. Word aft
7.8. Tables
7.9. Borders and Shading
7. l0.Footnote and Endnote
7. 1 1 .Tabs
7.12.Mail merge
7.13.Format Painter
7.14.Summary
7.15.Technical Terms
7.16.Model Questions

.7.17.References



7.1'.Views:

Sny document can be viewed in different fashions. These views can be
'selected from the view menu of the menu bar'

Normal view is a default view for all new documents. However saved
document will be opened last saved view, For example a document is
opened in normal view and saved in page layout view, when saved
docurnent is reopened, the document will be opefied in page layout
view,

Normal View

You can create and edit text or graphics normally, To work with header
and footers you invoked select item/Header. and Footer, Footer details
will not be displayed on screen.

This view will not show side-by-side c rn positioning, footers and
headers. Automatic page breaks dr€ sirw,ro as dotted lines. Manual
page breaks containing the words " Page Break".

Page layout View

In thid view headers & footers can be seen and edited' You can modify
the Header/Footer by the selecting the matter itself. It will display the
left side scale also.

Outline View

This view is used to see edlire contents of the
headlines and sections headings if your document is
It is useful if the document is large.

' Print Preview

Print preview is another way to view a document.
preview or Ctrl +F2, You can see one page to six
print preview.

document, chapter
properly formatted,

Choose file ) print
pages at a time in
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Split Screen View

You can see two parts of your
to make copying, cutting and
sim u lta neously.

document at once.
pasting quickly in

This feature is useful
both the documents

7.2. Spelling Ghecker:

To start the spelling checker, select Spelling and Grammar from the
Tools menu. MS Word will begin to check for misspellings, If a word is
found that is not in its dictionary, it pauses, displays the word, and if
possible, suggests alternatives (see figure below).

krsh hqry

F cf€t&gr€nnr

_eJ

Figure 7.2

You have several choices at ttiis point described in the table below. If
the word is spelled correctly, you can lgnore it or add it to a custom
dictionary by selecting the options, If the word is incorrect, you can use
Replace it with one of its suggestions or with a spelling you type in the
Change To: box.



fTo ignore only this occurrence of the word, click gnore

o agnore all occurrences of the word. click gnore All
-"-*i

I
"**-t

d

rst, click correct spelling in Suggestions list or type the correction
e Change To: box. Then...

o change only this occurrence of the word, click

o change all occurrence of the word, click hange All

7.3. Word Count:

Word count displays the number of
characters, pages in the document. Select
bar and click on the word count.

words, paragraphs, lines,
Tools menu from the menu

7.4. Macro.

Macros are advanced features that can speed up editing or formatting
you may perform often in a Word document. They record sequences oi
menu selections that you choose so that a series of actions can be
completed in one step.

Recording A Macro

To record a macro, follow these steos:
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Figure 7;4a

Click Tools/Macro/Record New Macro on the menu bar'

Name the macro in the Macro name field. This name cannot contain

spaces and or begin with a number.

From the Store macro in u up-down box, select the document you would

like the macro to be associated with or choose "All Documents" enabling

to use the macro in any document. Enter a description of the macro in
the Description field. This is for your reference only so you remember

what the macro does. Click OK to begin recording'

select options from the drop-down menus and word will record the

"ptt"r 
you choose from tlre dialog boxes, such as changing the

margins on the Page Setup window. Select only options that modify- the

docu-ment. word will not record toggle actions such as view/Toolbars

that have no effect on the document itself'

The recording toclbar will allow you to stop, pause, and resume

recording.
Clickthtstop button in the recording toolbar, The macro is now saved'

@l Figure 7.4b
rrnl

Sbre macto il:

lallDocuments 
("lormal.dot) :l



Runnlng A nacro.:
fo run an existing.macro, follow these stepsl

Figure 7.4c

Select Tools,/Macro/Macros from the menu bar,

From the Macros window, highlight the Macro name in the list and click
Run.

I_t!-9 T.u* !1 long and you want to stop it whi|e it is running, press
BREAK (hold CTRL and press PAUSE). : '
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7.5.Graphics:
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Figure 7.5.

Microsoft Word contains a full set of graphic tools. You can:

Create graphics from scratch.

Import graphics from other proErams.

Place graphics within text.

Manipulate graphics on a page.

Word cornes with some pre-designed graphics that are normally
installed in the MS OFFICE\CLIP ART folder. These graphics can be
resized and placed within text.

Inserting a Graphlt iFyaflr Eocument

To insert a graphic in a dotument position the insert point where you
wfft tdlrllace th graphic"in the text. Select Picture from the insert
menu. Cf;*k on Ef,p art, and double-click the graphic you want to insert.

.b*q
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Choose Insert, Picture, Clip Art or click the Insert Clip Art button orr the
Drawing toolbar.

Word opens the Clip Art Task Pane.

Search for a specific clip image by entering what you are looking for
within the Search field in the Task Pane.

Alternately, click on the Clip Organizer button toward the bottom of the
Task Pane to open up the Clip Art Organizer.

Select a clip and when Word shows a control palette, select the first
option, Insert Clip. The clip is insefted where your insertion point is
positioned.

You can also drag the clip art into your document.

Wrapping Text around a Graphic

By default text does not wrap around a graphic, To get text to wrap
around a graphic, do the following:

Right click on the graphic to get the short cut menu.

Choose Format Picture from the list displayed.

Select the Layout tab.

Choose the style of wrap that you like and click OK.

Resizing a Picture

Select the inserted picture by clicking once on it,

Click the Cropping tool on the Picture toolbar.

Notice that the mouse cursor has changed.

Drag one of the corners with the pointer to reduce its size and eliminate
it.

7



7.6. Lines and ShaPes

Use the Drawing toolbar to create lines, shapes, text boxes'

Autoshapes, WordArt, or CliP Art.

Drawing a Line or Arrow

Open a new Word document' Click the Drawing tool in. the Stand.ard

dJuu|. or right click in any toolbar on your screen to display a list of

available toolbars. select the Drawing toolbar. click a line or arrow on

ihe Orawing toolbar. When the cross hair (+) appears,.pointto a spot in

your docunient where you want the line or shape and draw a shape'

Drawang an AutoShaPe

click Autoshapes on the Drawing toolbar. select stars and Banners

from the drop down list of categoiies. select the shape you wa.nt. click

in- vout document and drag the cross hair that appears to draw the

snape.

Adding a Text Box:

C|icktheTextBoxiconontheDrawingtoolbar'Whenthecrosshair
.pp"utt, point to a spot in your document where you want the--text box

ini atu6. The box appears with an insertion point in it' Type "Microsoft

Word GraPhics" within the box.

7.7. WordArt:

To display the Word Art Gallery, choose lnsert, Picture' WordArt or click

tne Wbranrt icon on the Drawing toolbar. Double-Click a WordArt style'

Wora opens the Edit WordArt diilog box' Type the text you walt a1d^i!

*iff i"pfu." the sample text. Choos6 a font, font size, and style' Click OK

to close the WordArt Gallery and see your text'
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Figure 7.7
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7.8. Tables:

Creatang Tables Using the Menu

A table is a grid of rows and columns on the page, like a spreadsheet.
The area where a row and column intersect is called a cell. The number
and width of columns can vary from row to row. Cells are separated by
gridlines, which are non-printing separators. To display the table
gridlines, select Gridlines from the Table menu.

Each cell can contain a paragraph, multiple paragraphs of text, or
graphics. Microsoft Word wraps text within a cell in the same way that
text is wrapped at the end of a line of normal text. Text within cells can
be formatted, copied, cut, and pasted. You can add text, edit text,
change its size, add borders, or add and delete columns and rows.

To create a table, select the Insert Table command from the Table
menu. The Table Dialog box appears: enter the number.of columns and
rows you want to include in the table and click on the OK button, A table
with the number of columns and rows that you specified is inserted in
your document and the cursor is positioned in the first cell of the table.
You can move from cell to cell using the <Tab> key, to move forward to
the next cell. and the <Shift Tab> keys to move back to the previous
cell.
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Creating a Table Using the Table Button in the Standard Toolbar

The Table button on the T(: -ar provides another way to create a table'
To use the Table button, place the mouse on the Table button and press
the mouse button, The Table button selection box pops down. Drag the
mouse down to select the number of rows you want and to the right to.
select the number of columns. When you have selected the correct
number of rows and columns, release the mouse button. A table with
the number of cells you have specified is inserted in your document'

Selecting Tables

Cells in a table can be selected using the click-and-drag method or one
of the following techniques:

fo select a
cell:

Click in the lower left corner of the cell. (The mouse
pointer shape becomes a right pointing arrow')

To select a
row:

Single Click in the selection bar to the left of the row.

To select a
column:

Place the mouse on the top border of the column and
click. (The mouse pointer becomes a black down pointing
arrow. )

fo select
lhe entire
lable:

On a. Macintosh hold down the Option button and double-
click in the table. On a Windows machine Press the <Alt>
key and the number 5 key on the numeric keypad . (The
NumLock must be turned off.)

Io select
more than
one cell:

Drag the mouse across the desired cell selection.

Inserting columns and Rows

To insert a row or column within a table, select Insert Row or Column
options from the Table menu and position the insertion point in the
row/column you want to insert.

Changing Column Width

You can aditrst the width of a column, or you can adjust the width of all

the cells in a column. To change the column width, click on the column
width button. Drag the button to the left or right according to your
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needs' To change the width of all the columns select the entire table
and drag the column width button you wish to change,

7.9. Borders and Shading:

click and drag the first column width button to the 1.5-inch mark. click
on the Next column width button to the 3-inch mark. The mouse can
also be used to change corumn widths. To serect the column that you
want to change, place the mouse pointer on the right border of ihe
column, As you move the mouse pointer on top of the column borderthe pointer becomes a two-headed arrow (see exampre). when the
mouse pointer is displayed as the two-headed arrow, press the mouse
button and drag to reposition the corumn width. As you'drag t|," rolil,
an outline of the new border shows the border position. whien you have
resized the column to a satisfactory width, release the mouse button.
The entire column is resized accordingly,

Deleting Columns and Rows

To delete a column or row, select the column or row you want to delete
then select Delete column or row from the Table menu. Notice that ifyou select a column, the command is Delete Columns. If you select a
row, the command is Delete Rows.

You can add a border to any or all sides
pages in a section, to the first page only,
You can add page borders in many line
variety of graphical borders.

of each page in a document, to
or to all pages except the first,
styles and colors, as well as a
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7.1O. Footnote and Endnote:

Footnotes and Enctnotes are used in printed documents to .explain'
;;;';";i on, or provide references for text in a document' You can

include both Footnot"r-"nJ-Endnotes in the same document- for

example, you might use Footnotes for detailed comments and Endnotes

for citation of sources. Foltnotes appear at the end of each page in a

document, Endnotes rypically appear at the end of a document'

1. In print layout view, click where you want to insert the note

reference mark.

2. On thb Insert menu, click Footnote'

Click Footnote or Endnote'

Under Numbering, click the option you want'

Click OK.

word inserts the note number and places the insertion point next

to the note number.

6. Type the note text.

7, Scroll to your place in the document'

3.

4.

5.



7.11. Tabs:

By using tab key on the keyboard we can move the cursor by a fixeddistance in the document. By defaurt, every tab press, the cursor moveshalf-inch. But we can create our own tab positions. For creatinocustomized tab positions first we have to s"ie.t tn" t.o 
"r,gr,n;nibutton at the reft hand side corner of the rurer rine. Tabs ."n irro uecreated, by using the tab diarog box. select Format menu rrom-tnemenu bar and crick tabs ,option. Then we get rabs oiarog uoi. r-rere wJselect the type of the tab and distance uria .fiit or. britton. rn"n tf,"tabs will be set accordingry. Here oy using tio-diarog box we can arso

:I:.j" gn: more tab i.e., bar tab. Brthi;;";;n creare a verticat tine inthe text at the specified bar tab position.

7.12. Mall Merge:

Mail Merge is used to quickly create form letters, mailing labels,envelops and cataloos by merging the information from two differentfiles. Those two fireiare generaily the Main Document and Data source
ll_::,1ft:. creating those two fitei, they ii" ,"rg"O to get the desireoresutt. Generally mail merge is used to piint multiple copies of aparticurar retter addressgg [o r"nv r"roJir. For exampre circurars,Greetings & Invitations will come ,ni"i ,uii"r".ging.
Main Document

The main document c-o1tai1s the. subject mafter of the letter to beprinted. rt can contail jS"tt g."phl;;bje.i, uno fietds (data), which
ffin,irn5,r""f;1il":i,"" ietier. wnen-,r"iging, data wil be mersed

Data Source

Data Source file contains the information in the form of records, which isto be inserred to the T:il. !ocume;1. 
' 'i;';;" 

record, one member,sinformation is stored - for exam.ple on" p"o*;, address. The individualinformation in the records.is catied;;Jii:;il"'y the data written inthese fietds wi' be inserreo in *relmar:n';;:;;i;, during merge.
Merge requires 3 steps
Creating Main Document

Creating Data Source



Merging two files.

Creating Main Document

First, Open a new document to create a

rii"]n"*. Then select Tools)Mail Merge'

be displaYed on screen:

main document bY selecting
The following dialog box will

, ,"" an,t.n".*oa to sat trp a mail morq6' Bcgin by chooJino thc cta't'

! button.: .......,.... -. -

llffi mar' aocument

2 B o"." to*"'

J rrrrrrrrrrrrrrr m"rg" ttta data vllth the document

iJ[5,,T"llH,H:ii:""i:',:",:JlFiii:'rii'i:*:?5i::*"";',]"*
Ii*i,s;iii;"ot-:t9'."^.0,"1:"fl"*i**tiffiH*",;::.!?"S":*:l:
$Iff:1"J,"'i?"::j' I;" l;;""; ;-; nt i n th e active w i ndow'

Creatin
9 Data
Source

To
create a
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data source file click on Get Data in Data Source. The following will\be
displayed. Click on Create Data Source to specify the fields to be
included in the address, like name, place etc.,

The existing field names will be displayed on the screen to the right.
Unwanted fields can be removed by clicking on the field name and by
clicking on the field name and by clicking on the button "remove field
name". If any new fields are to be added, type the field name on the
left side, After specifying the field names, to type the contents, click on
ok. A dialog box will be displayed to specify a name for the data source.
Type the name and click on "Save". A dialog box is displayed asking to
edit the data source or edit the master document. The following diagram
sDecifies the sa me :

Type
the

details
oy

pressing
enter
after

typing
the first

name/
job title etc., for this, click on "Add new". After typing all the details
click on OK. Add contents to the document. Insert the merge fields in
the window document. Finally select tools-)mail merge. Merge dialog
box will again get displayed, click on "Merge".

7.13. Format Painter:

The Format Painter is a button on the Standard toolbar. It makes it
easy to copy all the formatting features of one paragraph to one or
more paragrapns.

To copy the paragraph formatting using the Format Painter you will:

1. Highlight the paragraph whose format you want to copy.

LBcordl



lcomputer Science 17 Mlcroson worq

2. Now click the Format Painter button on the Standard toolbar'

3.

4.

o If you press the button once, you will be allowed to copy the
' format to onlY one ParagraPh'

o If you double-click the button, the button will stay
depressed and allow you to copy the format to as many
paragraphs as you want. When you are finished you must
then click the Format Button once in order to turn off the
featu re.

Notice that your insertion point now has a Paint Brush attached to
it. This indicates that the format of the selected paragraph may be

painted or copied onto another paragraph.

Place your insertion point anywhere within the paragraph that is

to receive the format and click the left mouse button. At this point

the format of this paragraph will change. 
lt €,

7.14.Summary:

In this lesson we discussed the procedure of inserting a table in the
document. You can insert a table of required number of rows and

columns. In this lesson you have learnt the concept of mail merge and

its usefulness. The mail merge feature supports many word processors

that enable you to generate form letters. The mail merge feature of Ms-

Word requires mainly two components: the main document and the

data file. The main document is the body of the letter that has to be

sent. The data file contains the list of names and addresses in the form

of rows. You have learnt the procedures of creating the main document
and the data file, and combining them.

You have observed how to use spell checker, the macro capability, and

workingwiththegraphicslikeClipArt,WordArt,FormatPainter,
Footnote and Endnote features.



7.15. Technical Terms:

ClipArt

clipArt consists of pre-designed images that can be placed within a

document.

Data Form

A data form is a dialog box
records in a database.

Data Source

that allows you to view and edit individual

A data source contains the information from which a merged document
is created. The data source is merged with a main document, which

specifies the kind of output required.

Database

A database is a collection of organized information.

Dictionary

Word uses two kinds of dictionaries, a main dictionary and a custom
dictionary, The main dictionary cannot be altered; we can add words to

the custom dictionary.

Mail Merge

Mail Merge refers to the process of combining a data source, and a main

document to produce a unique output.

Wizard

A wizard is a feature of Microsoft applications that lets you

a series of dialog boxes to help you complete a task.
work through
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7.16. Model Questions:

1 . What is a macro? Explain the procedure for creating a macro?

2. How do you perform mail merge?

3. Explain the difference between Footnote and Endnote?

4. Explain the procedure to create a table?

5. Explain different views in Ms Word ?

6. Explain the graphic facilities in MS-Word ?

7.l7.Refereneces:

RON MANSFIELD,'Working with MS OFFICE', Tata Mc Graw Hill - 2000
Edition

GUY HART DAVIS' ' The ABC'S Of Microsoft Office. ' BPB
Publications, New Delhi

MS OFFICE 2OOO Comptete, BPB Publications' New Delhi

AUT"HOR:
Y. SURESH BABU' M.Com., M.C.A.' :
Lecturer,
Dept.Of Computer Science,
JKC College'
GUNTUR.



Lesson 8 - Microsoft PowerPoint

Objective:

This lesson introduces the basic features of Microsoft powerpoint,
Creating Presentations, View options, Inserting new slides and setting
background color scheme to the presentation.

Structure of the Lesson:

8,1. PowerPoint basics

8.2. Starting a presentation

8.3. PowerPoint window properties

8.4. Save a PowerPoint presentation

8.5. Copy and Move data in a powerpoint presentation

8.6. View options

8.7. Add a slide

8.8. Add/Modify text
8.9. Bullet styles

8.10. Speaker notes

8.11. Background/Colorscheme

8.12. Slide master

8.13. Headers/Footers

8.14. Summary

8.15. Technical Terms

8.16. Model Questions
8.17. References r'l



8.1. PowerPoint Basics:

PowerPoint is an application that lets you build, print, and deliver
piesentations. You'have several options for the delivery of a

presentation, but you only have to develop it once' You can print slides'

irint handouts, print notes pages, prepare for 35mm slides' or deliver

!n on-r.r"un presentation. bniy the on-screen presentation allows you

to use the full range of PowerPoint's features'

As you develop a PowerPoint presentation, it is- important to reme.mber

tnai you should not try to include every piece of information you wish to

deliver.PowerPointslidesshouldcontainbrief,concise'descriptive
phrases that will help you remember what you want to present and to

serve as a reminder for your audience.

8.2. Starting A Pre' .ntation:

Start PowerPoint by either of two methods:

1. Go to the Start menu. Choose Programs and then click on

Microsoft PowerPoint'

2.Doub|e-c|icktheiconofanyPowerPointdocument,Whenyou
doub|e.c|ickaPowerPointdocument,PowerPointopenswiththe
document alreadY loaded '

APowerPointpresentationconsistsofslidesthatcancontaintext'
jraphics, charts, and other data types' When you start PowerPoint' you

can start with a blank presentation, or you can begin from a template or

use the Autocontent Wizard.

The Autocontent wizard is series of step-by-step instructions designed

io assist you. The Template button -accesses. 
slide templates to help

create a consistent, professional look for your slide presentation'
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New Presentation Dialog Box

Autocontent wizard.walks you through a series of questions designeoto elicit information about you and the type of presentation yor- 
"."making. The wizard then builds a dummy presentation that will guide

you. in developing the content of the presentation.

Design Template alrows you to estabrish the background and coror
scheme from the available templates prior to beginning'work in the newpresentation. Template choices are generally easier to make after you
have opened the new presentation because you can better see the' characteristics of each template before making a selection.

Blank presentation opens 5 new presentation with no temprate, ooenan existing presentation di$plays a list of recentfy opened'powerpoinr
presentations from which you can choose. Or, you may choose More
Files to move to the location of a previously saved presentation file and
open it.



AutoLayout
After you have opened a new presentation, PowerPoint displays the New

Slide dialog box containing several Auto Layouts' Auto Layouts provide a
pre-determined layout for each specific type of slide' They provide

consistency throughout the presentation. Each layout depicted is

described in the lower right corner when you click the layout' This

sample New Slide dialog box shows the Title slide selected (denoted
'with the thick border).

New Slide Layout Dialog Box

8.3. PowerPoint Window Properties:

The Microsoft PowerPoint window hasr+nany of the same attributes as

other windows in the Microsoft office'suite. The table below lists the

different features and provides a brief descfiption of each one'

Besides the usud,ailindow([omponents, thefowerPoint window has

severa I u niq ue,elDrnGntsilfddEtifi ed i n the fi g u re below'
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Menu Bar

The words listed atop the application window, immediately underneath
the Title bar. You can access all application commands from the Menu
bar

Standard Toolbar

The Standard toolbar, located beneath the menu bar, has buttons for
commonly performed tasks like.._ printing, saving, inserting clip art, and
other operations. You can custotnize the toolbar or even display multiple
toolbars at the same time,
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Formatting toolbar

The Formatting toolbar, located beneath the Standard toolbar bar, or
possible to thJside of it, has buttons for various formatting operations

iike changing text size oi style, changing alignment, formatting bullets'

and animation

lttt€os8
Fd Sizr ltdic slEdow Nunbrdng Fott sze l Stig Si* De3gt

| | r l'-i-- | -l.r8 ' E r u g 
=== i=:=iA; r=iFa'Efos:in",:uew*ac'

llll-ll-l
rdo unailnc Argmcrr rcds Dqfr Fdi cou Nervsil

Drawing Toolbar

The Drawing toolbar on the bottom of the PowerPoint window contains

drawing and text tools for creating graphics'
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Slide Layout Task Pane

The area on the left side of the window that allow you to easily switch

between the Outline and the Slides views'

Slide Area

The area in the middle, in which you actually work on your presentation

slides

Task Pane

Theareaontherightsideofthewindowthata||owsyoutoeasi|yaccess
various command!. You can display different Task Pane options by

iricr<ing on the dropdown arrow in the upper right-hand corner of the

pane.
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8.4. Save a PowerPoint Presentation:

Changes you make to a document are not saved to disk until you issue
a Save command, Saving is quick and easy, and you should save often
to minimize the loss of your work, PowerPoint has two save commands,
Save and Save As, that work similarly. Both commands are on the File
menu.

Save

When you save a new presentation for the first time, PowerPoint
displays a dialog box similar to the Open dialog box. Select the disk in
which to save the presentation and specify a name for the file. When
you save an existing document that you have been editing, the newly
saved version replaces the older version.

Save As

This command displays a dialog box where you can choose a document
name and destination folder or disk. Use the Save As command
whenever you want to save a copy of the current document with a
different name or in a different folder or disk. The newly saved copy
becomes the active document

A presentation is normally saved as name. ppt file type. However,
PowerPoint Show with the extension of name.ppt.is also a useful file
type so that your file is able to run regardless of operating system.

8.5. Copy and Move data in a PowerPolnt Presentation:

Use the Copy and Paste commands to copy selected text and graphics
from one slide to another. If you want to move data instead, use the
Cut and Paste commands. To do this:

. Select the text you want to cut or copy by highlighting it.

. Go to the Standard Toolbar to choose the Cut or Copy short cut
icon.

. Move and click your mouse to the
to go. Note the cursor is blinking.

place where you want the text
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. Go to the Standard Toolbar to choose the Paste short cut icon.

8.6. View Options:

Power point offers different views for entering, editing and previewing
you r information. TheY are:

. Slide view

. Outline view

. Slide Softer view

. Notes Pages view

. Slide show view

Slide View

Slide view shows how our listed slides will work. We can move from one
. slide to another with pg up and p9 dn keys' We can edit text and other

slide elements in slide view.

Outline view

It will display all the text in the presentation. Here we can easily
rearrange line item. we collapse items in this view so that we can see

important headings or names of each slide.

Enter and Edit Text in Outline View:

powerPoint's outline Area lets you focus on the content of your
presentation, by typing up the outline prior to laying the presentation

out. After you type in outline, you can concentrate on how your
presentation looks

.The boundary of the Outline Area can be resized by dragging the

vertical separation to the right. This will make it easier to enter your

outline.
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€ntering Slide Titles and Bullets:

Typing in PowerPoint's Outline view is similar to using a word processor.
Type your slide title or bullet point and press Return to start a new slide
or bullet. To force a line break within a slide title or bullet, press Shift-
Enter. This starts a new line for the same title or bullet.

Move Slides in the Outline Area:

It's easy to change the order of your slides and bullets in the Outline
Area, Press the mouse button on the item you want to move and drag it
to the desired location, You can also select the item you want to move
and click on the Move Up or Move Down buttons,

Delete Slides or Bullets:

While working in the Outline Area, you can delete a slide by clicking on
the slide icon next to the title and pressing the Delete key. Delete
bullets and sub bullets similarly.

Slide Sorter view

It will show the slides in reduced size. We drop the sliders to move the
slides so that we can change the order of slides. We can make the slides
appear and disappear using the effects.

Notes Page View

It is to create and see notes to the presenter. It shows miniature slide
image and provides a text area for presenters notes.

' ,To enter notes

'.i.Ctict on the text area shown below this line. The box outline will
.change appearance.
2. Type and edit in the note box.

Slide show view :. r:

It will show the slides in reduced size. We drop the slides to mova the
slides so that we can change the order of slides. we can make the slides
appear and disappear using the effects.



When you right click on the slide it will show some options' In that we

can opt'Pen; to draw the temporary lines' These lines will not be saved

on the slides. To leave from the slide show press Esc.

Zoom

The Zoom adjuster lets you alter how large your slides

screen relativb to full-screen presentation mode' Click

drop-down list (in the toolbar near the top of the screen)'
View menu, and select Zoom... Select "fit", a default
type in your own number, according to your needs'

appear on the
on the Zoom
or click on the

percentage, or

8.7. Add a Slide:

In the Text Outline area, you can add a slide before or after an

existing slide.

.Toaddbeforeas|idepositionthecursoratthebeginningoftext
oftheslideinfrontofwhichyouwouldlikeanewslide,andpress
the Enter key.

. To add after a slide, position the cursor at the end of the text of

theslideafterwhich.youwouldlikeanewslide,andpressthe
Enter key (if you had indented levels of text on the previous slide,

usethePromote(|eftarrow)buttoninthetoo|baratthetopof
thescreentomovethetextbacktothe|efttoforceanews|ide.
+-'t

InNormal,Outline,Slide,orSlideSorterview,selecttheslidea'ter
which you wish to insert a new slide.

. Then click on the Insert menu, and select New Slide'

a new slide this way, .the New Slide window
you to select a slide laYout'

. When you add
appears, asking

. Select whichever layout is appropriate for the content you will

o|aceonthenews|ide.Theoneselectedintheexamp|eonthe
iignt ir "Bulleted List". lf the provided layouts don't meet your

nleds, select the bottom-right iayout, "Blank", which will provide
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you with a new empty slide, However, no matter which layout you
choose, you will be able to modify it later.

8.8. AddlModify Text:

Here are a few ways to insert or modify text in PowerPoint:
. In Normal or Slide view, select the slide on which you. wish to

insert text. If there is already a text box on the slide you may
click your mouse on it and start typing. Familiar word processing
tools for modifying text (color, style, font, alignment, etc.) are
provided.

. In Normal or Slide view, to add a new text box to a slide, click
on the Insert menu, and select Text Box. put your mouse over
the slide layout - the cursor will change to a narrow down-arrow
(as shown on the left below). Click, hold, drag, and release the
mouse to form a rectangle on the slide. Then you can type into
the -" text box created for you (as shown below),
, V/('o*'""'2
+ M//////B///////h

. To work directly in the Text Outline area, position the cursor at
the point where you would like the new text to appear and just
type.it in. Use the Promote r/ Demote buttons in the toolbar at
the tdp of the screen to create different levels of indentation. tF.,!l
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8.9. Bullet Styles:

Although you can set Bullet Styles in the Master, you also can change
the bullet style on any slide or on any bulleted point. When you change
the bullet style, every subsequent bullet on that slide, whether
promoted or demoted, will have that style until you change back to the
default or change to a different slide.

To change the bullet style, make sure the cursor is in the line of text ln
which you wish to change the bullet, then choose FORMAT: Bullet.
NOTE: Sometimes it is difficult to remember exactly what the default
bullet style was, so pay close attention to the selected bullet before
proceeding with any changes.

Format Bullet Dialog Box
You can choose from the selections provided by PowerPoint, choosing
both the size (in percentage of text size) and the color.

Click Character to ihclude any symbol font installed on your system.
Keep in mind, however, that if you choose a font that is not installed on
the computer from wlrich you are giving your presentation, the



presentation computer will choose the "closest" font to the one you

chose and the result may not be one you like. Both Symbol and

wingdings font are standard on most computers and should display as

v0u intended.

Adding / RGmoving Bullets

r.=
E=Jrne Bullet Tool is a toggle' Click it once to
beginning of the current line of text (the one
flashing). Click it again to remove the bullet'
bullets to text you have typed wiihout using the

place a bullet at the
in which the cursor is
This way you can add
Bullet AutoLayout.

8.lO Speaker Notes:

powerPoint has a facility for adding speaker notes to a presentation'

These can he notes that you create for yourself - for example, to help

you remember key points during a presentation - or you can create

ihem as additional information for your audience. After you have

completed a presentation, you can print the notes for each slide, along

with a smaller version of the slide' To add notes to a slide:

. Click on the View menu, and select Notes Page (you may want
to adjust the Zoom percentage to get a larger view)'

(Notes Page)
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8.11. Backjround / Color Scheme:

Design templates contain color schemes, slide and title masters with
custom formatting, and styled fonts, all designed to create a particular
look. Not only can you specify a design template when you begin a new
presentation, you can choose a design template (for the whole
presentation, not individual slides) any time while editing a
presentation. To do this, click on the Format menu, and select Apply
Design Template. A window will open asking you to choose a design.
Select one and click Apply. The name of the template chosen will be
displayed in the center of the status bar at the bottom of the PowerPoint
screen. If the status bar is not visible, click on the Tools menu, select
options, click on the View tab, and ensure that Status bar is checked.

J]$l

I

;

The background color of slides can be customized by clicking on the
Format menu / Background. Click on the drop-down list to select
either another color from the subset provided or click on More Colors
and Fill Effects to see other choices' One of the Fall Effects available is

Pacture (import an external image file to use as a slide background).
When you are done, click on Apply (if you wish to alter just the current
slide) or Apply to A|l (to alter all slides at once)'

'.a:tx

P.t.'|t.da.rt.ofil I
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standard tab or click the custom tab, click on the desired component
(e.g.Background),andclickChangeColor(acolorselectionwindow
wilf appear), When you are done'making color choices, click on Apply (if
you wish to alter just the current slide) ar Apply to All (to alter all

rhe color scheme for slides can be customlzed by clicking on Format /
Slide Color Scheme. Either chooses a preset scheme from the

slides at once).

I rdidirr
t rcr..t*.aia- l

,l
'rryqF I

..1
Dtil

8.12. Slide Master:

The Slide Master in a template is a slide that controls the formatting,
text; and objects that appear on every slide in your presentation. For

example, if you want a small picture of the world to appear on every
slide, place that picture on the Slide Master. To display the Slide Master,
chgose Master/Slide Master from the Yiew menu. You can then edit this
slide. Changes you make-to the Slide Master alqq appear on each slide
in your presentation.
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It is easy to edit the text of a slide
modify a slide's appearance, switch
changes to apply to every slide in the
Master from the View menu.

In Slide View just click on an object to select it, Then use the Format
menu to apply the change you want. For example, to change the font or
color of the slide title, select the slide title and choose Font from the
Format menu, The Format menu also has commands for centering or
left aligning text (Alignment), and changing colors (Colors and Lines).
You can even change the format of slide bullets using the Bullets
command on the Format menu, PowerPoint also has a Formatting
toolbar to simplify basic formatting tasks.

in the Outline Area. However, to
to Slide View, If you want your
presentation, choose Master/Slide

. Click to edit Master text styles

- Sccond lcv
. Third lcvel

- Fourtr lwcl
> Fifrh lqwl

i'Jiiiili""""""': i"""'"'--'?;;-""""""': i"""""""""'$'i
i..--......P*.q.9r.s.9..i i.-........-.-..-.....fcs!g.Sr.*.i i......Ns'lEr.8J9._.i

Sample Slide Master

8.13. Headers / Footers:

. On the View menu, click Header and Footer.

. On the Slide tab, you set options, the effect of the options
selected will appear at the bottom of slides:
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o Dat€ and time can be set to Update automatically (to
reflect the last date the slides were modified) or Fixed (type
a certain date such as when the presentation will be given).

o Selecting the Slide number option will automatically insert
a sequence number,

o Selecting Footer (and typing text in the box below it)
inserts fixed footer text.

o Selecting Don't show on title slide will omit the footer
from the title slide (but it will appear on the other slides).

o Normally you click on the Apply to All button to make
these changes throughout the presentation, but of course' you can click Apply to affect just the current slide,

. Similar options are available on the Notes and Handouts tab,
plus the option of adding a page header to your printouts.

t6. ld.arr.nd H.adrdr I
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8.14. Summary:

At the end of this lesson you have learnt the important features of Ms-
PowerPoint including creating a presentationr opening an existing
presentation and working with different kinds of slide layouts. We
identified different toolbars available in PowerPoint,

You are in a position to format the text, applying background color to
the presentation, working with master slide, applying speaker notes to
slide, applying header and footer to the document.

8.14. Technical Terms:

Slide: Brief, concise, descrintive phrases that will help you remember
what you want to present a, .: to serve as a reminder for your audience.

PowerPoint Presentation: PowerPoint presentation consists of slides
that can contain text, graphics, charts, and other data types.

Slide Master: The Slide Master in a template is a slide that controls the
formatting, text, and objects that appear on every slide in your
presentation.

Speaker Notes: Speaker notes can be notes that you create for
yourself, key points during a presentation, additional information for
you r audience.

8.15. Model Questaons:

1. What are the features of PowerPoint?

2. What is a Slide? Explain the procedure to create a Slide?

3. What is Slide Master? Write the procedure to create Slide Master?

4. Explain the procedure to create Header and Footer in PowerPoint?

5. Exolain the views available in PowerPoint?
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Lesson 9 - Microsoft PowerPoint

Objective:

This lesson introduces the Drawing Objects, Images and ClipArt, Audio
and Video, Slide Transition, Rehearse Timings and Charts.

Structure of the Lesson:

9.1. Working with Text

9.2, Drawing Objects

9.3. lmi,ges and Clip Art

9.4. Audio and Video

9.5. Creating Hyperlinks

9.6. Animating the presentations

9.7. Slide Miniature

9.8. Slide Transition

9.9. Slide Show Animation

9.10. Rehearse Timings

9.11. Slide Setup and Prlnting

9.12. Charts

9.13. Summary

9.14. Technical Terms

9.15. Model Questions

9.16. References



9.1. Working with Text:

Any time you wish to make formatting changes to text, you must
highlight the text to be changed. Making a selection from the Text
Toolbar affects the highlighted text only. In addition to the standard text
formatting tools of font choice and size, bold, italics, and underline, you
also can align text left, center, or right. Other special tools are described
below.

Shadowed Text

The Shadow Text Tool places a slight shadow behind the text. Although
the effect is not prominent, this is an excellent tool to use to give more
definition to title text. You should NOT shadow all body text since this
makes it very "muddy" to read.

Fl,r.iilin

1" : t 
-1. ,r .,,

not shadoned
Sample Shadowed Text

To shadow text,
1. Type the text to be shadowed.

2. Highlight the text.

3, l-s click the Shadow Tool.

Increase / Decrease Paragraph Spacing

9
[LEhh" Increase and Decrease paragraph spacing Toots expand and
contract paragraph spacing, respectively.



Format Painter

f-;l
ls,trne Format Painter Tool picks up any formatting applied to existing
text and applies that same formatting to any text it is "painted" over'
The two pieces of text need not be on the same slide.

To L re the Format Painter,

1. Highlight the text containing the formatting you desire to "pick
upl'.

2. Click the Format Painter Tool.

3. Press and drag over the text as you would to highlight it. The
formatting will be aPPlied'

After the formatting is applied the Format Painter will de-select'
To apply formatting to multiple selections of text without needing to
click the Format Painter between each application, double click the
Format Painter. The Painter will remain the selected tool until you click it
to de-select, allowing you to press and drag over multiple sections of
text, applying the same format to each'

Increase/Decrease Font Saze

iA il you can
text by clicking on
respectivelY. Size
sizes.

Text Golors

increase or decrease the font size of highlighted
the Increase Font Size or Decrease Font Size Tool,
increments and decrements by the standard font

Elvo, choose text colors with the Font Color Tpol located in the
Drawing Toolbar. Highlighted text will change to the color displayecl

in the band beneath the A.
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To make additional
you have used in
the A.

color choices or to see
this presentation, click

additional non-scheme colors
the drop-down arrow beside

Clnanl Sth.Ld
Cobr

a lba Curl.nl
Ot6bn Sslr.m.

tddltondlcolo|' you
mry h.lt rliot a o n

thir tr$tntrtron

Yora lont oohr

Font Color Choices

Word Wrap

Whether text is. in a Placqholder or a textbox, you can narrow or widen
the width of the box by dragging the box border. This affects where the
text wraps. Make sure the cursor looks like a two-headed arrow to affect
the Placeholder width; a four-headed arrow will move the placeholder.

9.2. Drawing Objects:

\ \ I' o draw a line, an arrow, a square, or a circle, select the
appropriate tool from the Drawing Toolbar. When you move the cursor
over the slide, it will be a crosshair. Press and drag the cursor to insert
the object. The larger an area you drag, the larger the object will
become.

TIP: To draw a straight line or arrow, or a perfect square or circle, hold
SHIFT as you press and drag.

Selecting

To alter any PowerPoint object, you first must select the object. When
you click the object, you will see Handles around the perimeter of the
object. This lets you know exactly which object you will be affecting.



Sample Hrndes *;

Deleting

To delete an object, click to select i!:, then press DELETE'

Fill Colorc

When you draw
automatic color.
color,

solid objects
The underline

(sguares and circles)i they'flllrr,fth the
under the PalntbuclGtJis thg'lcdrrGht ffll

El fo fill an object with the current fill color,'seldtut t'hs@edt,fthen
l

To change the current fill color, drop down the arrow. bq$-,!!:
Paintbuc[et and make a new selection. There are also additional bptions
To change the current fill color, drop. down the arrow. bcei

under Fill Effects, including choosing no fill colorat all'

click the Paintbucket Tool'

Aubntrtt Fill
Color

Colors h lhs Cufienl
Oedgn SthetrE

Addlliond
mat hde chosan in

hls p|3$nl3len

', ,'! .

Altcrneto Cholces for Fln Cobn
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Fill Effects

Fill effects include Gradients where you can select one or two colors of
your choice, as well as the direction and variants of the gradient.
Textures are image files similar to web page wallpapers; you can use
PowerPoint's selections or choose an image file from your workstation,
Patterns allow you to choose two colors and the pattern design with
which you want to fill the object. Picture allows you to choose an image
file from your workstation; the photograph will center itself within the
selected object, hiding any parts of the image, which do not
automatically show within the object's shape.

Gradients

tl
Oadent I Tcxtuc I pcttern I pktuc

Colorr - -

: (. qnc (dor
6 Two color:

a Prcrct

1. ..---',-t-l r

.''--',,.." .__._,-.'',. *.-*.1
- sfr.&|g sqiles " -.-- -- -r
( fbrBortal

a fcrti(.|am$':
c D.gon l davrn
C Frorn corncr

a^ Fr@ccrtor
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Photos

Line Effects

f-;-l'g Each drawing object has an outline the color of the automatic color.
The underline under the Line color Tool is the current line color. To
outline an object with the current line color, select the object, then click
the Line Color Tool.

To change the line color, drop down the arrow and make a new
selection. Other options with the Line Color Tool include cotor and
patterns similar to the Fill Tool.

E--lL-. Ll To
these tools,
selected.

change line style, dash style, and arrow style, click on
respectively, after drawing the object and while it is still

I e*tcrn
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Object Effects

lf f lro place a shadow or 3D effect otl an object, select the object,
then click the tool selection.

Autoshapes and wordArt

If you're not particularly artistic, AutoShapes and WordArt can come to
the rescue. To use AutoshaPes,

1. From the Drawing Toolbar, click the drop-down arrow beside

AutoShapes, and then select the shape type.

2.C|icktheshapeyouWant.Thecursorwi||changetoacross.hair
as you move the mouse across the slide'

3. Click on the slide where you want to place the shape'

4. Move the object, change its size or color, as desired'

2.

WordArt Tool.

WordArt GallerY, click the

Autoshapes Tool

Kho rt" WordArt,

Ciick the

From the
oK.

design you want, then click



,t

7

WordArt Gallery

3. In .he Edit WordArt Text box, type your text' You can also
change the font face and type size, or add bold or italics. Then
click OK.

The aft will be placed in the center of the slide and is always smaller
than you would like-press and drag the handles to enlarge the object
to the desired size.

Many of the WordArts also have one or more small yellow diamond-
shaped handles. You can press and drag any of these to distott the
shape of the object:

Samples of Word Art

To change the colors in WordAft, make sure the object is
choose FORMAT: WordArt and make your selections.

selected, then
:
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Text Tool

@ro in""rt text on the slide other than in a Placeholder

1. Click the Text Tool.

2, Press and drag the cursor over the slide to create a Text Box,

3. Type in the box.

NOTE: Any text you type in a placeholder will show in Outline View; text
inserted via the Text Tool is treated as an object and will not display in
the outline.

Moving
To move an object on the slide, select it, then move the cursor over the
object until you see the four-headed arrow along with the cursor. Press
and drag the object to the location you need it.

NOTE: Be sure it is a four-headed arrow rather than a two-headed
arrow. Two-headed arrows re-size objects.
To move a text box, select it, then move the cursor over the frame until
you see the four-headed arrow along with the cursor. Press and drag
the text box to the location you need it. If you move the cursor within
the box, it will change to an insertion point so that you can type or edit
text.

Rotatang

;s rro rotate any object, including a text box,

1. Click the Rotate Tool.

2. Click the object to be rotated.

3. You will see snlall gheen disks in place of the normal handles on
the object.
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.to.., fd'$l$
a

Sample Rotated Text
4. As you move the cursor over the disk, it will chdtrge to a looped

circle. Position the loop over one of the green disks and press
and drag to the desired rotation.

5. Click the Rotate Tool to deselect it.

Grouping and Ungrouping

Often after you have created multiple objects and layered them in the
sequence you need, you want them to "stay put". By grouping multiple
objects, you can move or resize them 'a single entity rather than
manipulating their individual component,

To group multiple objects:

1, Size each individual object as necessary'

2, Layer objects as necessary,

3. Each object must be selected prior to grouping' To select
multiple objects, hold SHIFT then click each object. Each object
clicked becomes selected and the handles of each are displayed.
Release SHIFT after you have selected each of the objects to be
grouped.

4. From the Drawing Toolbar, choose DRAW : Group. You will see
that the objects' individual handle-sets will be combined, leaving
a single handle-set for the grouped object.

Sometimes, if your object is very complex, you will flnd it beneficial to
group your object components incrementally. When you finish a subset
of your final object, group the components you have finished. Then you
can continue building additional components, knowing you won't
accidentally move or re-size the portion you have completed.
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Text that you include in a grouped object will not change point size if
you re-size the grouped object, however, word-wrapping may adjust to
conform to the re-sizing.

To manipulate individual components of grouped objects, you must
ungroup them. 1-o ungroup an object, select it, then from the Drawing
Toolbar, choose DRAW : Ungroup. After editing, you can choose Re-

9roup.

lffilTo access PowerPoint's ClipArt Gallery, click the ClipArt Gallen
Tool (located on the Drawing Toolbar).

To use a Gallery ClipArt ' l, in the
the category pertaining to -..- type of
select the image you want. A boP-uP
image, preview the clip, add the clip to
similar clips.

I + ,' g i$lwortchs '@Qrs

Seach lc: clbs: ,te or€ 0r flE(c {4cfos. . .

!U P€tu6

9.3. Images and Clip Art:

PowerPoint comes with a library of "clip art" that includes traditional clip
art, as well as Videos, photographs, and sounds. You can also insert
graphics from other sources into a presentation'

ffil
Insert ClipArt

Insert ClipArt dialog box, select
image you are looking for, then
box will allow you to: insert the
a different category, and/or find

Clps l .T ll Attnak

Dialog Box
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The greatest benefit of the ClipArt Gallery is that you can add multiple
selections to your presentation without leaving the Gallery,

ClipArt images will be inserted in the center of the slide. You can move,
enlarge, or reduce them,

To select multiple objects using the mouse,

1, Position your mouse cursor beyond the corner of the object to
be re-grouped. Make sure you start far enough beyond the
objects to catch all of the components.'

2. Press and drag diagonally across the objects to select all the
components. Make sure that you do not accidentally include an
object in the selection that you do not want to be selected, (You
may have to try this step several times, it is a bit tricky to
master. )

3. After all the components are selec d, from the Drawing
Toolbar, choose DRAW : Group (or Regroup).

9.4. Audio and Video:

Your presentation can link to external audio and video files.
. Select the slide on which you wish to add a link to an 'audio or

video file.

. On the Insert menu, point to Movies and Sounds,

To insert a sound from a file, click Sound from File. To insert a
video from a file, click Movie from File.

. A standard file directory window appears.

. Locate the folder that contains the audio/video file you want, and
then double-click the filename.
Note: In PowerPoint, by default your movie or sound will play

manually. If you want it to play automatically you will have to set
Custom Animation options for the slide.

. For audio files, a sound icon 't appears on the slide.
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. For movies, an image consisting of the first frame is displayed as
a placeholder.

. To preview the audio/video in Normal view, double-click its icon.

Note: Alternatively, you may have to use the Insert / Object
command since PowerPoint is not able to play all audio/video formats
inline. Insert / Object will open the media element in a new window
rather than making it appear embedded on the slide, and it will be
played by an external program.

9.5. Creating Hyperlinks:

Hyperlinks cause the selection of an object to result in a move to a new
location or the performance of an action. You can create your own
object or choose an AutoShape Action button.

To link an object with a- action, select the object, then choose SLIDE
SHOW: Action Settings.

In the Action Settings dialog box, choose either Mouse Click or Mouse
Over. Then select the button "Hyperlink to" then select the destination
or action. You can also choose to play a built-in PowerPoint sound
during this action and/or to highlight the object as you click it.

17 Eav rood:
lsae *orctor

l---". --l c-..r I

Hyperlink Action Dialog Box
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9.6. Animating the Presentataon:

To animate a single object on a PowerPoint slide

Select the object.

Choose SLIDE SHOW: Preset Animation.

1.

2.

3. Select the animation effect you desire for the selected object.

Preset Animation Dialog Box

Animated Layers or Slides

You may find it useful to bring a layered object into a presentation one
layer'at a time, building it on-scieen. To animate a layered object or to
animate each object on a slide

1. Choose SLIDE SHOW: Custom Animation. (You rnust be in
Normal, Outline, or Slide View.)
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2. In the Custom Animation dialog box, each object is identified in
the Check to animate slide objects list,

If you don't remember what a particular object is, click the
object's name in the list; that object appears selected in the
preview window.

3. Click in the object's checkbox to animate that object. It will be
added to the Animation order list.

4. To change the order that the animated objects appear, select
the object in the Animation order list, then click the up or down
arrow to move the object through the list.

5. Choose whether the object appears only on a mouse click or
after a specified number of seconds.

Chcck' .rh.te ilide ob,ects: foK*]
cancel 
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Layer Animation Dialog Box

To choose other effects such as sound effects and how the object
appears on the slide during the on-screen presentation, click on the
Effects tab.

To animate text,
1. Click on the Effects tab.

T"xt 3

A(tse lranE t
Prtse lrdne 5

Prctwc f rdne 6
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2, In the lntroduce Text section, from the drop-down box, choose
whether the text is introduced all at once, by word, or by letter'

To animate charts click the Chart Effects tab. You can choose to
introduce the data by series, categories, or elements.

NOTE: Be careful of using too many effects in any single presentation
because they soon become detraction to rather than an enhancement of
the prese:rtation.

9.7. Slide Miniature:

When you have zoomed the view of your slide so that all of the slide
cannot be seen on the screen at one time, PowerPoint will create a black
and white Slide Miniature in the corner. This allows you see the overall
effects of the changes you are making to the slide.

Sample Slide Miniature
You may also choose to work in black and white mode by choosing
VIEW: Black and White. To see a small color view of the current slide
when you are working in black and white, choose VIEW: Slide Miniature.

Holiday

o Fourth ofJuty
o Memorial Day

aNew Yer's Day

10'
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9.8. Slide Transitions:

Transitions determine the effects applied when you move from one slideto another during an on-screen presentation. you must be in slide
Sorter View to access the Transition Toolbar.

To choose only a transition effect, click the dropdown box beside the
words "No Transition" and select a transition. To have other transition
choices available to you, click the Slide Transition Tool.

f) | ruo rrans*ton

Sample Transition Tool and Drop-down Box

when you click the slide Transition Tool, the slide Transition dialog box
allows you to choose not only a transition effect from a drop-dowribox,
but also offers other choices that affect your on-screen presentation.

Sample Transition Dialog Box

TIP: Do not use a different transition on each slide because your
audience attention should remain focused on you and the content, not
the effects, If you want to use multiple transitions, a good rule of thumb
is to apply a unique transition to each slide in a specific module of the
presentation.

Generally, you should leave the Effect Speed set to Fast. This brings in
the next content slide quickly and keeps your audience's atteition
focused on the presentation content.

l- gn trErsr dck
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PowerPoint contains a few built-in sounds. To play a sound as the slide
is transitioning, make a sound selection from the Sound drop-down box,
Unless you have a well thought out reason for doing so, do not choose
to have the sound loop until the next sound; it can become annoying
very fast while you are giving a presentation, as well as making.it
difficult for you to speak over, Also, many presentation locations do riot
have adequate speakers attached to the computer to allow all of your
audience to hear the sound.

. In Slide or Slide Sotter view, select the slide or slides on which
you want to add a transition.

On the Slide Show menu, click Slide

From the Effect drop-down list, click
the transition you want.

Select any other options you want
(speed Slow/Medium/Fast, Advance on
mouse Click or Automatically, Sound or
No Sound)

. To apply the transition to the selected
slide, click Apply. To apply the
transition to all the slides, Click Apply
to All.

. Repeat the process for each slide you want to add a transition to.

. To view the transitions, on the Slide Show menu, click
Animation Preview,

9.9. Slide Show Animation:

You can control how and when text, graphics, and other objects appea'r
on your PowerPoint slides, For example, you can make graphics or text
items appear one at a time and add visual or sound effects. Animation
can aid in focusing attention during a presentation and make your slide
show more interesting. To set slide show animation options, display the
slide that has the objects you want to animate, then on the Slide Show
menu, click Custom Animation.

Transition.
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Timing Tab
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In PowerPoint, ensure that you are on the Timing tab.

Under Slide obiects without animation, double-click the
objects you want to animate.
(they should be moved up to the Animation Order box).

Use the up and down arrows to the right of Animation Order to
change the sequence in which objects will appear (move objects
up or down in the list).

Under Start Animation set the timing (when objects will appear).
Select each object and then do one of the following:

o To start the animation by clicking the object, select the On
mouse click option.

o To start the animation automatically, select the
Automatically option, and then enter the number of
seconds you want to have elapse since the previous
a n imation.

l. Obiccl 2

3. Ob,e(t 4

l- o( I
cn'cel I

Aevi.w I

t: Automatk€ty, F-g

SfidE obixts v\*t|out {*n!till



Nagariuna Universitv 22 Centre for Distance Educati

Effects Tab
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Click the Effects tab to set options for visual or sound effects.

Under Entry animation and sound select the options you want.

To preview the animation effects, click the Preview button'

In the example above, the object will enter the screen with a

Spiral animation and the Chime sound will play.

Animating a text box containing bulleted text

. On the Order & Timing tab, the text box is selected with a check
mark, and the On mouse click option is chosen (to let the
Dresenter control the slide show with mouse clicks).
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. On the Effects tab, the options set below will make each line of
text enter the screen with a Fly From Left animation, No sound
will play, and when the next line of text appears the previous line
will change to a lighter color (a dimming effect). To preview the
animation effects, click the Preview button.
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The series of images below show what the screen looks like after each
mouse click when the slide with the bulleted text (set with options as

above) is displayed during a Slide Show. Notes that the previous text
Doints are dimmed as each subsequent line appears.

9.1O. Rehearse Timings:

The Rehearse Timing Tool allows you to practice giving an on-screen
presentation, regardless of any slide advance timings you may have set
previously. The tool sets time not only for the entire presentation, but
also each individual slide, as you rehearse. Each time you advance the
slide, the time is recorded, You must be in Slide Sorter View to access
the Rehearse Timing Tool.

Toi.lTim.
Tlm. oar lor

Naxt Pau5!
Slid.

Sample Recorded

R.p.i
Rahcartal ol

this Slid.

Rehearsal Timings

l@l To uru the Rehearse Timing Tool, click the Rehearse Timing Tool'
When you have completed rehearsing, PowerPoint displays the total
time for the rehearsed presentation and asks if you want to record the
'new timings. If you click "Yes", these new timings will replace any slide
advance timings you may have previously set for the presentation.

Sample New Timings Dialog Box



9.11. Slide Setup and printing:

Before you print your slide
orientation is correct, Also,
black and white.

Change these settings using
File menu.

Slide Setup

presentation, make sure the slide size and
decide whether you want to print in color or

the Page Setup and print commands on the

The slide setup dialog box has controls for slide size and orientation.
Choo-se the appropriate slide size and orientation Uefore you aosignificant fo.rmatting .in your presentation. changing sride orientationrrom portratt to landscape or vice versa may require editing andreformatting slides.

Printing

f.9 .nri1t /our slide presentation, choose print from the File menu, orclick the Print button on the toorbar. In the print diarog box vo, t*choose. how mgny copies you want to print. Use the priit Wnai: aroj_
down list to select whether you want to print just the srides, notei, 6rhandouts with multiple slides per page.

9.12. Charts:

To insert an organization chart (depicts hierarchicar relationships):
. First display the slide on which you want the chart to appear,
. On the Insert menu, point to plcturc, and then click

Organization ChaqD

. A separate Microsoft Organization Chaft window appears.
i Use tne UuttOhb dt'tiie t6p of the Organization Chart window to

add text boxes to your chart (above, below, or beside existing
boxes).
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Click your mouse inside a box to edit the text inside of it.

As shown in the example below, you can use this type of chart for
almost any type of information you want, not just managers,
workers, and other positions within a company.

uvrng I nrngs

Fungi i Plantae

To create a b::r or pie chart (or similar chart based on numbers in a
datasheet):

. First display the slide on which you want the chart to appear.

. On the Insert menu, click Chart - or click the Insert Chaft
button on the PowerPoint toolbar, 0

. A sample chart and datasheet (spreadsheet) appear on the screen' as shown below,

. To replace the sample data, click a cell on the datasheet, and then
type the information you want.

. To change the chart type, on the Chart menu, click Chart Type.
In the Chart Type window, which
appears, click on the desired Chart
type and sub-type and then click the
OK button.

To return to PowerPoint, where you

!o
ao

lo

];;rl
l8e."t I
|l!e-ral

:



can move and size the chart, click outside the chart on the
PowerPoint slide.

. If you wish to re-edit the chart, double-click the chart on the
PowerPoint slide.

At the end of this lesson you have learnt how to insert and format text,
working with the pictures and inserting images into a slide. The

concept of Slide transition, Slide animation, Rehearse timings allows you

to auiomatically move to next slide without manual interaction. A

layman can also know more about the data results with the help of
charts.

9.13. Summary:

9.14. Technical Terms:

Hyperlink: Hyperlinks cause the selection of an object to result in a

move to a new location or the performance of an action'

Slide Transition: Slide Transition determine the effects applied
when you move from one slide to another during an on-screen
presentation.

Slide Show Animation: Slide Show Animation can aid in focusing

attention during a presentation and make your slide show more

interesting.

Rehearse Timings: The Rehearse Timing Tool allows you to practice
giving an on-screen presentation, regardless of any slide advance

timings you may have set previously.

slide setup: The slide setup controls for slide size and orientation.



9.15. ltlodel Questions:

1. Explain the procedure to draw the objects in PowerPoint?

2. Define Hyperlink? Explain the procedure to create Hyperlink-s in
PowerPoint?

3. What is a Slide Miniature?

4. Define Rehearse Timing? Explain the procedure to set the
rehearse timings to slides?

9.16. References:

RON MANSFIELD,'Working with MS OFFICE', Tata Mc Graw Hill - 2000
Edition

GUY HART DAVIS, ' The ABC'S Of Microsoft Office. ' BpB
Publications, New Delhi

MS OFFICE 2OOO Complete, BPB Publications, New Delhi

AUTHOR:
c.v.P.R.PRASAD, M.C.A.,
Lecturer,
Dept.Of Computer Science,
JKC College,
GUNTUR.
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Lesson tO - Microsoft Access

Obiectave:

This lesson provides an introduction to the fundamentals of Microsoft
Access. It covers starting Ms-Access, creating Data bases, Tables,
Queries, Forms, Reports, and Relational Data Bases.

Structure of the Lesson:

10. 1, Microsoft Access Introduction

10.2. Starting Microsoft 'ss

10.3. Creating and opening Data bases

10.4. Tables

10.5. Query

10,6. Relational Data Bases

10.7. Forms

10.8. Reports

10.9. Summary

10.10.Technical Terms

10.11.Model Questions

10.l2.References



10.1. Microsoft Access:

Microsoft Acce.ss is a powerful program to create and manage your
databases. It has many buirt in feaiures to assist you in consi*itingand viewing your information. Access is much more involved and is amore genuine database application than other programs such as

Microsoft Works.

Database File: This is your main file that
encompasses the entire database and that is
saved to your hard-drive or floppy disk.

Example studentDatabase. mdb

Table: A table is a collection of data about a
specific topic. There can be multiple tables in
a database.
Example #1) Students
Example #2) Teachers

Field: Fields are
within a Table.
multiple fields.

Example #1) Student
Example #2) Student

.he different categories
Tables usually contatn

LastNa me
FirstNa me

Data types: Data
has 1 data type.

types are the properties of each field. A field only

it)atabas<:

1O.2. Starting Microsoft Access:

Starting Microsoft access in
l. Double click on

rd
Mic,osort
A,cccss

two ways.

the Microsoft Access icon on the desktoo.

2. Click on Start --> programs --> Microsoft Access



10.3. Creatang New and Openlng Existing Databases:

If you start MS Access a window will appear as below'

The above Window gives you the option to:
. Create a New Database from scratch

. Use the wizard to create a New Database

. Open an existing database

. The whit'e box gives you the most recent databases you have
'used. If you do not see the one you had created, choose the More

, Files option and hit OK. Otherwise choose the database you had
previously used and click OK.



Cl€ate a datFbase using the Database Wizard

1. When Microsoft Access first starts up, a dialog box is automatically
displayed with options to create a new database or open an
existing one. If this dialog box is displayed, click Access
Database Wizards, pages, and projects and then click OK.

If you have already opened a database or closed the dialog box
that displays when Microsoft Access starts up, click New
Database on the toolbar,

2. On the Databases tab, double-click the icon for the kind of
database you want to create.

3. Specify a name and location for the database.

4. Click Create to start defining your new database

Create a database without using the Database Wizard

1. When Microsoft Access first starts up, a dialog box is automatically
displayed with options to creatc a new database or open an
existing one. If this dialog box is displayed, click Blank Access
Database, and then click OK.

If you have already opened a database or closed the dialog box
that displays when Microsoft Access starts up, click New
Database on the toolbar, and then double-click the Blank
Database icon on the General tab,

2, Specify,a name and location for the database and click Create.
(Below is the screen that shows up following this step).
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1O.4. Tables:

A table is a collection of data about a specific topic, such as students or

contacts. Using a separate table for each topic means that you store

that data only once, which makes your database more efficient' and

reduces data-entry errors'

Tables organize data into columns (called fields) and rows (called

records).
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Create a Table from scratch in Design view

1.tf you haven't already done so, switch to the Database Window
You can oress F11 to switch to the Database window from any
other window.

2. Double-Click on "Create table in Design view".
(DESIGN VIEW)

Cre.tc tda. bry ut8lc w(! d
c?.dc trblc br ..*.fhg d.a.

.l l,



3. Define each of the fields in your table.

o Under the Field Name column, enter the categories of your
table.

o Under Data Type column, enter the type you want for your
categories.

The attribute of a variable or field determines the
kind of data it can hold. For example, in a Microsoft
Access database, the Te)C and Memo field data types
allow the field to store either text or numbers, but the
Number data type will allow the field to store
numbers only. Number data type fields store
numerical data that will be used in mathematical
calculations. Use the Gurrency data type to display or. calculate currency values. Other data types are
Date/Time, yes/No, Auto Number, and OLE
object (Picture).

o Under the Description column, enter the text that describes. what your field is. (This field is optional).

o For example
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Primary Key

One or more fields (columns) whose value or values uniquely
identify each record in a table. A primary key does not allow Null
values and must always have a unique value, A primary key is
used to relate a table to foreign keys in other tables.

In the above example, the Stdid # field the primary key, meaning
that every student has a student identification number.

" To do this, siglply select the Stdid # field and select the
primary key button.
?l

o. After you do this, Save the table

SrFitching Views

. Views are two types. They are Design view and Datasheet view.
You can select the views from view menu from menu bar.

H
Displays the view, which

allows you to enter raw data
into vour database table.

ffi
Displays the view, which allows you

to enter fields, data-types, and
descriptions into your database table.
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Entering Data

Click on the Datasheet View and simply start "chugging,, away by
entering the data into each field.

lanipulating Data
. Adding a new row

o Simply drop down to a new line and enter the information.

. Updating a record

o Simply select the record and field you want to update, and
change its data with new contents

. Deleting a record

o Simply select the entire row and hit the Delete Key on the
l:eyboard
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1O.5. Query:

Queries are questions about your database. You can design a query
manually, specifying all of the tables and fields you wish to display on
your screen, or you can use a Query Wizard to create simple displays in
predefined formats.

QUERY WIZARD

Access provides several query formats

. simple - looks like the Table datasheet view
c crosstab - is similar to a spreadsheet with summary information
inserted into the intersection of each row and column
. find duplicafes - lists the records which have duplicate values in any
soecified field
. find unmatched - compares two tables and identifies records, which
do not have a match in a related table.

Using Query Wizard

From Database window:

. Click Query Tab

o Click New

o Select Query type from list (OK)

. Follow prom pts:

- select Tabtes / Queries (Next)

- select Fields (Next)

- create a Title

- click Finish.

In general, there are two types of query: Select and Action. A select
query gathers, collates and presents information in usable forrns. An
action query makes changes in specified records of an existing table, or
creates a new table. In this course, we will concentrate on select queries
only. ,
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Sometimes, information is scattered in many tables. For example,
tustomers' information is stored in Customers table while their
ordering information is stored in Orders table. In order to retrieve
information from more than one table, queries are used.. Moreover,
queries are capable of performing the functions of filters, namely adding
selection criteria and sorting instructions. In addition, queries allow
calculation of new fields.

In contrast to a filter, a query is reusable, When a table is closed, the
selection criteria and/or sorting instructions will be lost, Therefore, in
order to retrieve the same records again, the filter has to be recreated,
However, a query allows the selection criteria and/or sorting instructions
to be saved and reused.

Create a Query

Find all the products under the category Beverages and the total costs
for each of these products. In addition, you have to find the suppliers'
information of these products.

1. Click the Query button and then the New button in the Database
window.

2. Click New Query in the resulting dialog box to open the design
window for a new query.

3. From the Add Table dialog box, select Categories, Products
and Suppliers tables. Click Close to close the Add Table dialog
box.



4. Drgg the Category Name and Description fields from the
Categories field list to the first and second column in the grid.
Then drag the Product Name fields from the Products field list
to the third column. Finally, drag the * field from the Suppliers
field list to the foufth column.

5. In the fifth column of the grid, type Cost: IUnit Price]xIUnits in
Stockl*O.7.

6. Select the Criteria row in the Category Name column and enter
Beverages.

7. Run the query by clicking the Run button (l) in the tool bar.

8, To

9. To

print the result,

save the query,

choose Print command from

choose Save command from

the File menu.

the File menu.
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1O.6. Relationships:

After you have set up multiple tables in your Microsoft Access database,
you need a way of telling Access how to bring that information back
together again, The first step in this process is to define relationships
between your tables. After you have done that, you can create queries,
forms, and reports to display information from several tables at once.

A relationship works by matching data in key fields - usually a field with
the same name in both tables. In most cases, these matching fields are
the primary key from one table, which provides a unique identifier for
each record, and a foreign key in the other table. For example, teachers
can be associated with the students they're responsible for by creating a
relationship between the teacher's table and the student's table using
the TeacherlD fields. Having met the criteria above, follow these steps
for creating relationships between tables.

1. In the database window view, at the top, click on Tools --->
Relationshios

2, Select the Tables you want to link together, by clicking on them
and selecting the Add Button

3. Drag the primary key of the Parent table (Teacher in this case),
and drop it into the same field in the Child table (Student in this
case.)
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4. Select Enforce Referential

" When the Cascade Update Related Fields cl^eck box is set,
:hanging a primary key value in the primary table
automatically updates the matching value in all related
recoros,

o When the Cascade Delete Related Records check box is set,
deleting a record in the primary table deletes any related
records in the related table

5. Click Create and Save the Relationship

1O.7. Forms:

A form is nothing more than a graphical representation of a table, You
can add, update, and delete records in your table by using a form,

A form is very good to use when you have numerous fields in a table.
This way you can see all the fields in one screen, whereas if you were in
the table view (datasheet) you would have to keep scrolling to get the
field you desire.
Create a Form using the Wizard

It is a very good idea to create a form using the wizard, unless you are
an advanced user and know what you are doing. Microsoft Access does
a very good job of creating a form using the wizard. The following steps
are needed to create a basic form:

UP'iate

Dliete t

'-r 
Msl

,I- ,.,:,<cade

I t I l!':AOe
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1, Switch to the Database Window. You can do this by pressing Fl1
j on the keyboard.

2. Click on the Forms button under Objects on the left side of
screen.

3. Double click on Create Form Using Wizard

4. On the next screen select the fields you want to view on your
form. Most of the time you would select all of them.

5, Click Next.

6. Select the layout you wish.

7. Click Next.

8. Select the style you desire.

9. Click Next.

lo.Give you form a name, and select Open the Form and enter
information.

11.Select Finish.

12,You should see your form. To adjust the design of your form,
simply hit the design button (same as with the tables), and adjust
your form accordingly.

1O.8. Reports:

A report is an effective way to present your data in a printed format.
Because you have control over the size and appearance of everything on
a report, you can display the information the way you want to see it.

Create a Report using the Wizard

As with the Form, it is a very good idea to create a report using the
wizard, unless you are an advanced user, Microsoft Access does a very

; good job using the wizard to create reports.

1; Switch to the Database Window. You can do this by pressing F11'on 
the keyboard.
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2. Click on the Reports button under Objects on the left side of
screen,

3. Double click on Create Repoft Using Wizard.

4. On the next screen select the fields you want to view on your
form. Most of the time you would select all of them.

5. Click Next.

6. Select if you would like to group your files. Keep repeating this
step for as many groupings as you would like.

7. Click Next.

8. Select the layout and the paper orientation you desire,

9, Click Next.

10.Select the style you desire.

11.Click Next.

12.Give you report a name, and select preq'iew the Report.

13.Select Finish.

14.You should see your report. To adjust the design of your report,
simply hit the design button, and adjust your repoft accordingly.

1O.9. Summary:

At the end of this lesson you have learnt what is a database, which
contains Tables. Queries, Forms and Reports. Table is a collection of
data to a specific content which contains some rows and columns. you
have learnt the procedure how to create tables and Queries. eueries are
questionnaires to a database. A form is nothing more than a graphical

" representationSit-a table, You can add, update, and delete records in
your table by using a fgrm. Reports are used to present your data in a
printed format.
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1O.11. Technical Terms:
'!

Database: A database is a collection of information stored in a
computer in a systematic way, such that a computer program can
consult it to answer questions.

Table: A table is a collection of data about a specific topic, such as
students or contacts,

Primary Key: Primary Key is a field or whose value or values
uniquely identify each record in a table.

Query: Queries are questionnaires to a database,

Form: A form is nothing more than a graphical representation of a
ta ble.

Relationship: Relationship is used to bring the information back
together again.

Report: Reports are used to present your data in a printed format.

10.12. Model Questions:

1. Explain about the creation of databases in Ms-Access.

2. Explain the procedure to create a Table with an example?

3. Define a Query? Explain the procedure to create query-using
relationships?

4. Explain diff€rent data types in MS-Access.

5. What is a Primary Key?

6. What is a Form? Write the procedure to create a form in
different ways?
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Lesson 11 - Microsoft Excel

Objectives:

This lesson introduces the basic features of Microsoft Excel, a spreadsheet
program, entering and editing data, formatting, formulas, page setup, and printing

spreadsheets.

Structure of the Lesson:

11,1. Excel Features

11.2. Starting Microsoft Excel

11.3. Formula Bar

11.4. Working with Excel

11.5. Entering and Editing Data

11.6, Row and Column Headings

11,7. Auto Fill

11.8, Custom Fill Lists

11.9, Row or Column Size

11.10.Inserting Rows and Columns

11.l l.References

11,12.Chafts

11.13,Summary

11.14.Technical Terms

11.15.Model Questions

1 1.16. References



11.1. Features of Excel:

Answer wizard: Like word; excer has a new feature cailed answerwizard. It uses ..IntelliSense,, to determine wnat tina-oi;;:-;;;
need, based upon your questions,

Autocalc: When we se.lected a group of numbers, the sumautomatically appears on the status area. 
'We 

can see average, countthe numbers by right clicking on the status area.

Auto Complete: Auto comp.lete will try to figure out what you intendtotype,b,asedupontheentriesyouhavea1reidymade'

Auto correct: Excer ca.n-a-utomaticaily correct the mistakes. It wiil notallow two consecutive initiar caps, .airit"titin! names of days and soon. You can create your own auto coriect entiies,
Drag And Drop: Like other office features we can clrag and drop thegroup of cells using mouse. We can drag the specified iortion oi?;;one worksheet to other,

cell tips and Scroil Tips: when you touch the scroil bar it wiil dispraythe row and corumn number that you are heading for. This i. sr"uiio'l.large worksheets, you can use Cell tips to reao notes you,ve made foryourself in cells.

Data Map! It is having a data map feature. We can make maps ofdifferent regions in different countries, Thigcan be quite impressive inpresentations. This can be helping you in our business matters.
Easier retrieval of Documents: It has greafly streamlined filemanagement' It can quickry find worksheets a-no you can easiry dereteor rename files from the open dialog box.

Number Formatting: It_is easy to format the numbers with Excel,snew number-formatting. feature, ffrere are many types of formatshere like telephone riuribers, aoffar amoinir]"no a"t"r,
Templates and Wizards: A.variety of templates (pr.edefined) foriats-available with excer for use, ;n .ousiiress oi9-unl"tion.. we cah have a ,template wizard to link database wittL iroilsne"tr. if-wl'il;changes inthe worksheet, automatically databaie updated. .



11.2. Starting Excel:

On the PC, select Start, Programs, and Microsoft Excel from the Start

list.

Components of the Excel Window

Besidestheusualwindowcomponents(closebox,titlebar'scrollbars'

"t.), 
un Excel window has several unique elements identified in the

figure below:

Mrou Bar

Toolbar

Formula Bor

Fill H.ndl!

HortShaat Tab
Scrolling

I
StbJ, atta wgrkho.t Tlb!

11.3. Formula Bar:

In addition to the other toolbars the formula bar is located under the

iorrulting toolbar at the top of the Excel worksheet' Use the formula

bar to enter and edit worksheet data'
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The contents of the active cell always appear in the formula bar. When
you click the mouse in the formula bar, an X and a check mark appear.
You can click the check icon to confirm and complete editing, or the X
to abandon editing.

11.4. Workins with Excel:

opening and Closing worksheet

To open an existing Excel workbook, choose Open from the File
menu or click the.Open tool on the toolbar. Excel will display the
Open dialog box, which is similar in appearance and function to the
Save As dialog box. It contains a File Name: box for you to type a file
name.

To open a file, select the appropriate location by clicking on the down
pointing arrow next to the Look fn: selection box. Excel will display all
Excel files found there. Select the file you wish to open and click Open
to open the file,

l)_
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Saving a worksheet

To save an untitled Excel workbook, from the File menu choose Save
As or click the Save button on the toolbar. The Save As dialog box
contains a text box for you to type a specific filename, a "Save File as
Type: " box to save your workbook in a different format that other
programs can read, a selection box to. designate the folder and drive in
which to save the file, and a "Places Bar" that offe rs other locations to
save your file.

Creating a New Workbook

If you are already in Excel and you want to create a new workbook,
choose New from the File menu or click the New tool on the toolbar.

Managang Multiple Workbooks
Excel enables you to have more than one workbook open

simultaneously, Each open workbook appears on the Window menu'
The document with the check next to it is the active document. To

switch to another document, simply choose that document from the

Window menu. 'To navigate between worksheets within a workbook,

click the worksheet tab you want to activate. Double-click a worksheet

tab to change its name.
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11.5. Entering and Edating Data:

Entering Data
You can enter text, numbers and dates in an Excel worksheet, In
Excells terminology, numbers and dates are called values and text is
referred to as a label. To enter data of any type, click on the cell you
want to contain that data, and then type the information you want in
the cell. When you begin typing, your data also appears in the formula
bar. When you have finished typing the data for the active cell, press
the Return or Enter key. 

t
Editing Data
The easiest way to edit the contents of a cell is to select the cell and
then retype the entry. The new entry replaces the old contents. For
example, to change the number in cell CB to 123, select cell C8, type
123 and press Return. This method works well with numbers, but is
more difficult when editing long text labels or formulas.
The formula bar gives you inore flexibility while editing. When the
mouse pointer moves into the formula i.';,a;, it changes shape to an I-
beam, signifying that you can enter or edit text. isxt in the active cell
appears in the fornrula bar and you can edit it there. Use the mouse to
select the text you want to change in the formula bar and then type
the new text. Excel automatically replaces what is selected. Don't
forget to press the Return key when you finish .,diting a cell.

You can also edit labels and values directly in cells, Dcuble-click on the
cell you want to edit. This puts an insertion point in the cell. Edit the
contents of that cell.

Moving the Active Cell
Cell selection and movement around the worksheet are similar
operations in Excel. To sFlect a given cell or make it active, simply
click on that cell. Use the mouse or the arrow keys to move around the
worksheet. For example, if you press the right arrow key twice you
move two cells to the right,



Name box
The Name box displays the r..,grence of the selected cells.

11.6. Row and Column Headings:

Letters and numbers identify the rows and columns on an Excel
worksheet, The intersection of a row and a column is called a cell. Use
row and column headings to specify r cell's reference. For example,
the cell located where column C and row 8 intersect is called C8.

Active cell
The active cell has a dark border around it to indicate your position in
the worksheet. All text and numbers that you type are inserted into
the active cell. Click the mouse on a cell to make it active.

Fill handle

The lower right corner of the active cell has a small box called a Fill
Handle. Your mouse changes to a cross hair when you are on the Fill
Handle. The Fill Handle helps you copy data and create series of
information. For example, if you type Monday in the active cell and
then drag the Fill Handle over four cells, Excel automatically inserts
Tuesday, Wednesday, Thursday, Friday and Saturday.

Worksheet tabs

An Excel workbook consists of 3
worksheet tabs at the bottom of
worksheets within a workbook.

worksheets by default. Use the
the screen to navigate between

Go To Command

A quick way to move a large distance on a worksheet is wtrh the Go To
command on the Edit menu. When you select the Go To command, a
dialog box prompts you to identify the cell. Enter the cell reference
and click OK or press Return.

Clearing Cell Contents
To clear the contents of a cell choose Clear from the Edit menu. Then,
select what you want to clear from the cell: All, Formats, Contents, or
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Notes. Most frequently you will want to clear the Contents of a cell.
Pressing the Delete key also clears the contents of cells.

Undoing Mistakes
If you make a terrible mistake and you accidentally delete important
data. Use the Undo command on the Edit menu or the Undo tool to
correct the mistake.

Copying and Moving Data
Copy selected data from one cell to another with the Copy and paste
commands, or with the Drag and Drop procedure, If you want to move
data use the Cut and Paste commands, or the Drag and Drop
orocedu re.

Drag and Drop

This procedure does not involve the Clipboard and works best when
moving data a short distance.- To move cells, position the mouse on
the cell borders. Wait until the mouse pointer changes to a left-
pointing arrow then press and drag the data to the new location.

11.7. Auto Fill:

A series of. numbers, month's names or week names can be filled
automatically in Excel. For doing this simply type the first word in a
cell then place the mouse .pointer on the fill handle and then drag it
either horizontally or vertically so that Excel fills the Oata
auto matica lly.

11.8. Custom Fill Lists:

Excel providing a facility to create our own fill lists we can create our
college courses, names, a series of your colleague,s name, ,These are
the steps to create custom lists.

. Select Tools/Options

. Click on custom lists.

. Click on New list on custom area.
-r Type your list of entries in list entries area.. Select add button.



. Your new list will be created.

11.9. Row or Column Size:

The height of a row or the width of a column can be changed to any
desired value,

Row height

Select the row, which you want to increase the height, select Row from
format menu. Specify the value. Then automatically the height of the
Row increases,

Or

Select the row, then place the mouse pointer on the bottom boarders
of the row then the mouse pointer changes. Press left mouse button
and drag the mouse downwards until the desired row height reaches.

Column Height

Select the Column, which you want to increase the width. Select
Column from format menu, Specify the value. Then automatically the
width of the column increases.

Or

Select the column, then place the mouse pointer on the top boarders
of the column then the mouse pointer changes. Press left mouse
button and drag the mouse downwards until the desired colurnn width
reacnes.

11.10. Insefting Rows and Columns:

Select Insert menu form menu bar and select row option. Then
automatically the row will be inserted. Similarly select Insert menu
from menu bar and select column option. Then automatically a column
will be inserted.
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11.11. References:

About cell and range references
A reference identifies a cell or a range of cells on a worksheet and telis
Microsoft Excel where to look for the values or data you want to use in
a formula. With references, you can use data contained in different
parts of a worksheet in one formula or use the value from one cell in
several formulas. You can also refer to cells on other sheets in the
same workbook.

Relative reference
Relative cell references are references to cells relative to the oosition
of the formula. When you create a formula, references to cells or
ranges are usually based on their position relative to the cell that
contains the formula. In the following example

cell c2 contains the formula =A2*b2; Microsoft Excel finds the value
one cell above and one cell to the left of c2. This is known as a relative
reference, When you copy a formula that uses relative references,
Excel automatically adjusts the references in the pasted formula to
refer to different cells relative to the position of the formula. The
formula in cell c2 =a2*b2, the formula has been copied to cell C3.
Excel has adjusted the formula in cell C3 to =A3*b3, which refers to
the cell i.e., one cell above and to the left of cell C3.
Absolute reference

Absolute references, which are cell reference, ,n", u'*uys refer to cellsin a specific location. If a dollar sign precedes the letter and/or
number, such as gAg1, the column and/or iow reference is absolute.
Relative references automatically adjust when you copy them, but
absolute references do not.

5

7
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For example:

=a2+b2

The total amount is calculated by the formula rat*qty + vat. The fixed
vat price has to be applied to all the transactions. Here we are
applying absolute reference for the cell f2. i.e., $F$2,

Named reference

You can assign names to cells or ranges of cells. When you do that,
you can use the names in your formulas, For example, if you had a

column named QTY and a column named Price, you could create a
formula like = eTy * price.

tl.l2. Charts:

Excel fias features for preparing charts for the selected data in a
worksheet, A chart can be drawn in the same worksheet in which data
is available or can be drawn as d separate chart sheet. Chart sheets
have again tabs in thetab area;;which operates as worksheets tabs.
All charts in Excel are available in chart wizard so that a chart can be
prepared very easily by.using this special chaft wizard.
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The Best Chart Types

There are a lot of different chaft types out there, and it can be
confusing to work out just which chart type you need for a particular
set of data. Some of the most common types of chart and their uses
are explained below. The definitions of the chafts remain the same no
matter what operating system you use, Or what spreadsheet program,

Pie Chaft Type

Pie charts should only be used if you want to show proportions. This
chart type emphasizes the relationship between the whole and each
part of that whole. A good example of this would be .c display data on
what spreadsheet program is preferred by 100 of the top spreadsheet
experts.

Column/Bar Chart Type

The bar chart is undoubtedly the king of all chart types, Its simplicity
makes it so useful for a range of data types, It is the best chart type to
use if you need to compare values.

Scatter Chaft Type

Scatter charts (also known as XY-Scatter charts) cari be used when
you need to display two related sets of data on a chart, particularly if
you want to make predictions based on the data.

Lane Chart Type

Line charts should generally only be used where there is a period of
time involved. These charts are perfect for displaying trends, For
example, if you want to chart the increase in use of open source
spreadsheets during a S-year period, the line chart would be an
excellent choice for your chart type.

The first step to making our chart is to select the
charted.

range of data to be



The Chart Wizard can be started by using the Chart Wizard button
on the. Standard command bar (left) or from the Chart"' button on

the Insert menu. The data can be selected prior to running the chart

wizard, filled in while running the chart wizard, or added to the chart
later. The Chart Wizard runJ through a series of steps that help you

set up your chart.

Step 7 - Select a Chart TYPe

The Standard Types tab of step 1 of the chart wizard shows a list of

chart types on the left side, and several chaft sub-types on the right'
The Custom Types tab has a number of built-in custom types of

charts, including several combination chafts. You can add your favorite
custom chart types to the User-Defined list.
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Step2-SourceData

The Data Range tab gives you a preview of the chart style you selected
in Step. 1, indicating where the chart's source data range is, and
allowing you to plot by row or by column. The first dialog box below
shows a column chart, plotted by rows. The second shows an area
chart plotted by columns.
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Clicking on the Series tab gives you the option to add or remove some
of the data series in the selected source data range. you can change
the Name, Values (Y axis), and Category labels (X axis) of each series,
by editing the contents. of the respective box, or- by clicking on the
Range selection button -1J, then dragging with the mouse.

Fshr.u rtc*, ---*---E

Step3-ChartOptions

This step allows you to provide
axes, to select which and what
whether to show other options,
labels.

a title for the chart
kind of axes to put
such as gridlines, a

and for the chart
in your chart, and
legend, and data
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Step4-ChartLocation

Here you tell Excel where to place the chart. You can put
onto its own sheet with a name that you enter in the box
says "Chartl'') or you can embed the chart as a chart object
the existing worksheets (or chart sheets), which you select
droD down Iist.
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In this lesson you learnt the basic features of spread sheet. Excel is
used . for performing accounting problems. In this chapter we
introduced the concept of inserting, modifying and deleting
rows/columns, We have learnt the procedure of chahging the size oi
rows/columns and changing the data in a cell. Excel is having different
types of references like Relative, Absolute and Named references. The
data can be represented in many ways; using the different types of
charts we can represent the data in effective manner.

11.13. Summary:

ll.t4. Technical Terms:

Active Cell: The active cell has a dark border around it tc indicate
your position in the worksheet.

Relative Reference: Relative cell references are references to cells
relative to the position of the formula,

Absolute Reference: Absolute references, which are cell references
that always refer to cells in a specific location,

Formula Bar: Use the formula bar to enter and edit worksheet data.

11.15. Model Questions:

1. Explain
2. Explain
3. Explain
4. What is

the features o MS-Excel
different references in MS-Excel
the Chart feature in MS-Excel.
Auto Fill ? Explain Custom Fill List feature MS-Excel.
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lesson 12 - Microsoft Excel

Objectives:

This lesson inboducee the baslc featr.rres of Mictosoft Excel, Plcturcs and Autro'

shap6, Workshe€t Fomattlng, Woll<sh€€t Prlntry, Wod<sheet as Database and
Macro in Excel.

Structure of th€ l33ton:

12;1. Plctures and Auto shapes

. t2.2. Worksheet Formattlng

12.3. Functions

12.4. Worksheet as Data base

12.5. Worksheet Prlntlng

12.5. Mainc

12,7. Summary

12.8. Technical Terms

12.9. Model Questlons

12.10.References

+
13

i'.'. J



U 2 Centre for Distance Educati

12.1. Pictures and A: -l shapes:

Pictures

Excel has a feature of Inserting pre-deflned pictures or clipart into the
worksheets. All these features are avallable'under Insert Menu of the
menu bar.

Inserting Clipart

Select the worksheet area in which you want to insert clipart. Select
insert menu from the menu bar, cllck plcture, and clipart. Now we see
lot of pictures in a dialog box. Select Clipart tab, category, select an
image and click insert. Then automatically the selected lmage will be
displayed in the worksheet and then flgure will have small squares
around the surface. These are called handles and are used to increase
or decrease the size of the image.

Inserting plcture form flle

We can also insert pictures form a flle. For thls select insert menu from
the menu bar and cllck picture from flle, Then we see a dialog box in
that select the required folder ln whlch the file is available and the
name of the file and click on the Insert button. Then the pictures from
the file will be inserted into the worksheet.

Inseftang Auto shapes

An auto shape can be inserted into a worksheet. For tnis select Insert
menu from the menu bar and click picture and in it Auto shape. Then
different shapes will appear in the dlalog box. From that select the
required auto shape. Now place the mouse pointer in the sheet where
you want to draw the auto shape. The mouse pointer looks like a +
sign. Then press the left mouse button and drag the mouse diagonally
or towards rlght so that the selected auto shape will appear in the
worksheet. After reaching the requlred auto shape then release the left
mouse button. The slze of the auto shape can be increased or
decreased and also you can rotate the auto shape by an angle using
the auto siape tool bar.
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12.2. Worksheet Formatting:

Alignment of cells

Generally in Excel by default all the text will be aligned left and
numbers to the right. But we can align text or number in the desired
fashion. Select Format menu from the menu bar, Cells, then activate
the Alignment Tab. There are two types of cell alignments they are
Horizontal and Vertical alignments.

In the case of Horizontal alignment we have default option left
(contents are aligned left), right (contents are aligned right), center
(contents are aligned center), fill (contents are duplicated so that they
fill the cells), justify (aligned left and right) options available.

In the case of vertical alignment we have Top (contents are aligned
top), center (contents are aligned center), bottom (contents are
aligned bottom), justify (contents are aligned top and bottom) options
are available.

Excel allows Text Wrap option. When we type text, if the text
overflows then adjacent cells will be used, But in the text wrap of. r

there will not be any overflow instead the cell width will be increase'l
to accommodate the text.

Number Formatting

Entering and formatting numbers

Numbers are referred as constant values or values.
numbers 0 to 9, you can enter the following symbols.

+ -( ), . s vo
It treats commas and other dolor signs correctly, and
entered in scientific notation (2.5E+2)

Dafferent Number Formats
General

Number
Currency
Accounting
Date
Time

In addition to the
That are

it accepts nu mbers
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' Percentage
Fraction.
Scientific
Text
Special
Custom

When we enter any number it will take the number in general format.
We can change the type of cell after entering the numbers in a cell,

For example If you activate a cell in the General format, then type a
number with a dolor sign (g), the cell's format will change from general
to currency format.

When a number is too big to be properly displayed in its cell, excel after
displays a series of pound signs (######) instead of the number.
Some times excel switch to scientific notation to accommodate a large
number.

Entering Dates and Times

You can enter dates and times by typing item in most commonly
accepted American formats,

LL/7/97
11-Nov-97

Nov 7,1997

The excel stores dates and times as serial numbers using January 1,
1900 at the stating date that in one (1). The serial number 2 stand
January 2, 1990. You can change the date format to number, and
number to date. If we enter 8/93, the system automatically displays
accepts as Aug-93.

If we enter numbers starting with' (single quote), the entered data will
be treated as text.

Fonts for Cells

To change the, font size, font style, Bold, Italic and Underline, select
the cells in which we want to change the font, Select Format menu
from the menu bar, Cells, then activate the Font Tab, Now apply font
style, size, bold, italic etc., and click OK. Now the selected cells will be
formatted accordingly.
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Auto Format

Excel has some pie-defined formatting schemes, and those can be
utilized directly instead of formatting worksheet.

Select the cells, which are to be auto formatted and then select Format
from the menu bar and click Auto Format. Then we get auto format
dialog box on the screen. Here click the required format style, and
click O.K. Then the selected cells will be formatted according to the
selected pre-defined auto format.

12.3. Functions:

The various MS-Extel functions are classified as:

1. Statistacal function:

Function Purpose

SUM0 It computes the sum of a particular defined range
or range names, Ex: sum(al:a4)

Average( ) particular defined
- Average(a1:a4)

It computes the average oi a
range or range numbers. Ex:

Counto It counts the number of non blank cells in
particular definbd range or range names.
count(a1:a4)

a
Ex:-

Maxo
Ex:

It will display the maximum value from a
particular defin€d range or range names.
max(a1:a4)

Min0 It will display the
defined range or

minimum value from a particular
range names, Ex:- min(a1:a4)
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2. Mathematical function:

3, Trigonometric fun-.,wns:

These functions are used for trigonometric calculations on a list
of values. Some commonly functions like SIN, COS, TAN, ACOS,
ATAN, ACOSH, ATANH and DEGREES etc.

Syntax:- function (cell address/value)

4. Financial functions:

These functions are used to compute loans, depreciation, cash
flow etc., Some commonly used financial functions are MTE, FV,
PMT etc.,

RateO: It calculates the rate of interest per period. The syntax is
RATE(nper, pmt, pv, fu, type, guess). Here nper is the total
payment period, pmt is payment made per period, pv is
presentlvalue..gf the total amount, fu is the future value, type is
the number 0-or 1 dgpending upon whether the payment is to be
made at the end of the period or at the beginning respectively.
Guess is the guess value for the rate of interest.

Function Purpose

ABSo It will calculate the absolute value of a number,
Ex:- abs(-9) will display as 9.

Int( ) It will round off the number down to its nearest
integer. Ex:- int(19.34) will display as 19

Modo It will calculate the remainder after integer
division, Ex:-mod(5,2) will display 1

Roundo It will round off the
number of decimal
display 19.34 if cell

number down to a specified
places. Ex:- round(a1,2) will
a1 contains t9.345678

Sqrto It will calculate the square root of a positive
number, Ex:- sqrt(9) will display 3.
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For example, amount of loan = Rs.50,000 to be paid in 24
monthfy installments of 3,000 each. Here nper = 24, pmt=-
3,000, pv=50,000 fv=0.The default guess is too/o. Now
RATE(24,-3000,50000,0,0,10) will display 1olo as rate of interest'

PMT0: The purpose of PMT0 function is to compute the equal
periodic payments required to pay off a loan. The general syntax
of PMT0 function is PMT(rate, nper, pv, fv, type)

Here fu and type are optional, Suppose if you want to take a

loan of Rs.2,00,000/-. The annual interest rate is 14olo and has
to be paid in 15 years in equal monthly installments' Here rate is
L4o/o/L2, nper is 180 (15 * 12) and pv is 2,00,000. Here fv is

zero by putting all these in the formula

Pmt( 14l12, 180,200000).

12.4. Worksheets as Data Bases:

Excel is a spreadsheet application but can also be a used as a

database. There are two limits for using Excel as a database, The first
one is that only one person at a time can enter data into the database.

The second limit is a matter of quantity of data. Each sheet in an Excel

workboqk comprises 65,000 rows and 256 columns. An Excel

workbook can comprise up to 256 sheets. We are talking about
4,292,608,O00 cells.

Excel needs to recognize your set of data as a database or you will not
have access to any of the database functionalities from the "Data"
menu item (Sort, Filter, Form, Subtotal).

The DATABASE is a set of columns and rows in your spreadsheets
without empty rows and empty columns. Many cells can be empty but
never an entire row or an entire column.

The database must have a single title row. Use "Text Wrap" in
Format/Cells/Alignment to write more than one line of text in one cell.

The DATABASE must be surrounded by empty rows and columns (row
"1" and column "A" of the worksheet are considered preceded by an
rmpty row or column),
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So anybody can develop a database in Excel. You don't need to
ldevelop complex forms to enter data, you don't need to develop
queries you just use SUMPRODUCT, INDEX/MATCH and SUBTOTAL
formulas to develop reports by yourself when you need theni and that
have the layout that you need,

Excel is the most user friendly analyzing and reporting application so
they don't need to train a few analysts on other reporting applications
creating a bottleneck at the report development level. Adopting Excel
also allows all the analyst and decision makers to develop significant
analysis and reports improving the bottom line of the whole
corporation,

Using Data Forms

A data form is used to allow easy manipulation of information in an
Excel data list. While a list is small--for instance, when it fits on one
screen--it is easier to enter or change information directly. When you
start getting a larger , tumber of records, then you may find using a
data form to be easier, A data form is a dialog box that displays one
complete record from yuJr list at a time. Excel considers a record to be
a single row in your data list, so a data form basically extracts the
information from a row, uses the field labels from the flrst row of the
list, and displays the information so you can understand it easier, To
utilize a data form, follow these two simple steps:

Creating Data Forms in Excel

When you have to input a data into a worksheet, using an Excel
generated data form may make the job easier. your worksheet should
contain column titles as in the example below:

in the first cetl in the row directly
, Form. If you receive the message

6l
i1.

glick
Data

below your titles,
below, click OK.

then select
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Your data form is created and ready for data entry.

Type your data, tabbing between fields and press Enter or click New

after each record to add it to the worksheet.

r -: *r '.: L=l

NFF I

Name Check

Smilh John

ci.e*, ffrif-
&so-t, 163-- .

When you are done entering records, click Close.

Sorting Data:

1. Select the columns that you want to sort.
2. Click Data>Sort.
3. In the sort window choose the column or columns you

sort bY.
4. If you have a heading row make sure the Heading row

selected.

want to

option is

Amourl

14
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Click OK.
The data will now be sorted.

Filter Data:

1. Click Data>Filter>AutoFilter.

2. The first row of the spreadsheet becomes the filtering row.

3. To filter for specific data, click on the down arrow next to the
head of the column you want to filter by.

4. Then select the criteria you want to filter for.

5. You may filter by multiple columns at once by repeating steps 3-
4 for each column you want to filter by,

5.
6.

8l r* Eot

D6EIU
A1

!ic|{ lGrrt

6D7

3rt1995 34.312.T3



12.5. Worksheet Printing:

Page Breaks

Tosetpagebreakswithintheworksheet,selecttherowyouwantto
appearjustbe|owthepagebreakbyc|ickingtherow's|abe|'Then
chooselnsert|PageBreakfromthemenubar.Youmayneedtoc|ick
the double down arrow at the bottom of the menu list to view this

option.

Page Setup

Select FilelPage SetuP from the menu bar to format the page' set

margins, and add headers and footers'

Page

select the orientation under the Page tab in the Page Setup window

t" |lrur" in" p"g" Landscape or portrait, The size of the worksheet on

in. p"g" can'afio be formatting undei Scaling. To force a worksheet

rto prini only one page wide so all the columns appear on the same

pqge, select Fit to 1 Page(s) wide.
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Add preset headers and footer to the page by clicking the
down menus undar the Heedef/Foqt9f tab,

: rlflf l:

)i( ::-., 'l
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t



To modify a preset header or footer, or to make your own, click theCustom Header and Custom Footer buttons. A new window willopen allowing you to enter text ih the left, center, or right on thepage.

_:"r ?T *i-"
EN gE gH Eq

bmerbd Ttr n"rJr,lc

Format TerG - Click this button after highlighting the text to change
the font, size, and style.
Page Number - Insert the page number of each page.
Total Number of pages - Use this feature along'wiih the page
number to €reate strings such as ',page 1 of 15,'.
Date - Add the current date.
Time - Add the current time.
File Name - Add the,name of the workbook file.
Tab Name - Add the name of the worksheet,s tab.
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. Sheet

Check Gridlines if you want the gridlines dividing the cells to be
printed on the page. If the worksheet is several pages long and only
ttre first page includes titles for the columns, select Rows to
repeat at top to choose a title row that will be printed at the top of
e'ach page.

v iggfg:J I

Print Preview

Select File lPrint Preview from the menu bar to view how the

worksheet will print. Click the Next and Previous buttons at the top

of the window to display the pages and click the Zoom button to view

the pages closer. Make page layout modifications needed by clicking

the Page Setup button. Click Close to return to the worksheet or

Print to continue printing.

Print

To print the worksheet, select File lPrint from the menu bar.

T ddl rd vtiS!
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Lexmark Optrn 5 t 650

. Print Range - Select either all pages or a range of pages to
Drint.

. Print What - Select selection of cells highlighted on the
worksheet, the active worksheet, or all the worksheets in the
entire workbook.

. Copies - Choose the number of copies that should be printed.
Check the Collate box if the pages should remain in order.

Click OK to orint.

12.6. Macro:

Macros can speed up any common editing sequence you may execute
in an Excel spreadsheet. In Macro two options are there. They are
Recording a Macro and Running a Macro.

Recording A Macro

In this example we will make a simple macro that will set all the
margins on the page to one inch.
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. Click Tools lMacro lRecord New Macro from the menu bar'

Name the macro in the Macro name field' The name cannot

corr. r!n spaces and must not begin with a numbc' '

If you would like to assign a shortcut key to the macro for easy

use, enter the letter under Shortcut key' Enter a lower case

|ettertomakeaCTRL+numbershortcutandenteranuppercase
letter r.o assign a CTRL+SHIFT+number shortcut key' If you

select a shortcut key that Excel already uses, your macro will

overwrite that function '

Select an option from the store macro in drop-down menu'

Enter a description of the macro in the Description field' This is

for your reference only so you remember what the macro does'

. Click OK when you are ready to start recording'

. Select options from the drop down menus and Excel will record

the options you choose from the dialog boxes, such as changing

the margins'on the Page Setup window' 
-select 

FilelPage Setup
and chaige all the maigins to 1". Press OK' Replace this step

with whatever commands you want your macro to execute'

Select only options that modify the worksheet' Toggle actions

such as ViewlToolbars that have no effect on the worksheet
will not be recorded.

. Click the Stop button the recording toolbar' The macro is now

saved.
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Running A Macro

' To run a macro you have created, select Tools lMacro tMacros
from the menu bar.

. From the Macros window, highlight the Macro name in rhe tist and
click Run.

. If the macro is long
press BREAK (hotd

and you want to
CTRL and press

le it is running,stop it whi
PAUSE).

12.7. Summary:

In this lesson we have rearnt how to insert graphics in Excer. you have
learnt the usage of functions. Functions are 

-difFerentiated 
into different

types. We can use the functions with respect to our application. It isthe best way to see the output in print preview fashion before we aregoing for final print. worksheet can also be used as a Database. you
have learnt the concept of using Data Forms. By using the Data Form
we can enter the data and treat it as a record. we can sort the data
and can filter the data with respect to our criteria.
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12.8. Technical Terms:

Data Form: A data form is used to allow easy manipulation of
infor:matisn in an Excel data list.

Page Orientation: Page Orientation is used to set the page
Landscape or Portrait,

12.9. Model Questions:

1. Explain the usage of functions of Excel?

2. Explain the procedure to use the Data Forms in Excel?

3. Explain the concept of formattr; r {ata in excel?

4. How you can use the worksheet as a Database? Explain.
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